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S Corporations (1120S)

The basics of data entry for an S corporation (1120S) return are the same as for a 1040 
return. Field- and screen-level help, shortcut keys, and navigation throughout data 
entry all function as they do in the 1040. See the Drake Software User’s Manual: Tax 
Year 2013 for the basics of using the program.

What’s New in Drake for S Corporations

Drake programs its tax software according to the latest IRS rules and regulations. The 
2013 program reflects all changes to credits and deductions, including discontinua-
tions. For details on the new regulations for the 2013 tax year, see the IRS instructions 
for Form 1120S.

Calculation Results Window

Several new indicators of e-file eligibility have been added to the enhanced Calculation 
Results window to tell you if a return has already been accepted, if it is being suppressed 
by an option you chose, if it is not e-file-eligible because you did not select it for e-file, or 
if a type of return is not available for e-file. The status of extensions will also be displayed.

As always, a green check mark is displayed in the EF Status column of the Calculation 
Results window (see Figure 1) when the default product (Form 1120S) is eligible for
e-file, and a red X is displayed when the product has EF messages keeping it from being
e-file-eligible.

Figure 1: More indicators are now available in the EF Status column
Tax Year 2013 1



What’s New in Drake for S Corporations Drake Software User’s Manual Supplement: S Corp
For details on the Calculation Results window, see Chapter 6, “Return Results,” of the 
Drake Software User’s Manual: Tax Year 2013

Searchable Selector Field

The selector field, located at the bottom of all Data Entry Menus (Figure 2) can now 
search for screens by screen code, name, or keyword.

Figure 2: Searchable selector field

You can still type a screen code, state abbreviation, or form number in the selector field 
and press ENTER to open a particular screen, but for those times when you can’t remember 
the screen code or form number or on which tab of the Data Entry Menu the screen is 
located, you can now search for the screen with keywords or phrases.

For details, see Chapter 3, “Basics,” of the Drake Software User’s Manual: Tax Year 2013.

Electronic 
Signatures 

(e-Sign)

Drake’s 2013 tax software supports electronic signature pads that allow taxpayers and tax 
preparers to digitally sign authorization forms and consent forms, such as Form 8879-S, 
IRS s-file Signature Authorization for Form 1120S, and Form PMT, the ACH Payment 
authorization. 

Go to our online store at http://drake.computimeonline.com/ for details or to purchase a 
Drake-recommended e-pad.

For details, see Chapter 6, “Return Results,” of the Drake Software User’s Manual: Tax 
Year 2013.

Officer 
Compen-

sation

For tax years beginning in 2013, an S corporation must use Form 1125-E to report com-
pensation of officers if the corporation has total receipts of $500,000 or more. In Drake, 
officer compensation for such S corporations is reported on screen E. See “Compensation 
of Officers (Form 1125-E)” on page 9 for details.

Form 3115 
Attachments

Form 3115 must be attached as a PDF for all business return types. We have included an 
EF message that will automatically generate the PDF button to appear in the View mode 
toolbar so that the preparer can attach the form as a PDF.

For instructions on attaching a PDF to a return, see “Binary Attachments in Chapter 5, 
“Return Preparation,” of the Drake Software User’s Manual: Tax Year 2013. You can also 
read the Screen Help or the instructions on any PDF screen, or read the “Attaching a PDF 
Document” article on the FAQ screen in any package.

Account 
Type - State

The Account Type drop lists, located at the bottom of the Electronic Fund Withdrawal 
(PMT) screen, are used to differentiate between business and personal bank accounts 
when paying state taxes by direct debit.
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Contact 
Information

New e-mail, phone number, and fax number fields for the clients have been added to 
screen 1 (Name, Address, General Information). These fields are for reporting pur-
poses and are not included in the e-file record, but the e-mail address entered here will 
be the default address assigned to any e-mail you send to the client through Drake’s e-
mail program.

Required 
Fields

We have highlighted more fields that require completion before a return is eligible for 
e-file (see Figure 3). You can change the colors at Setup > Colors and turn off the warn-
ings at Setup > Options > Data Entry tab.

Figure 3: Required fields in blue

Sch M-1 
Worksheet

Worksheet was added to explain the adjustments flowing to Schedules M-1 and M-3.

Form 1099-
PATR

A new data-entry field on screen 8903 (Domestic Production Activities Deduction) 
allows entry of distributions received from a cooperative and reported in box 6 of Form 
1099-PATR, Taxable Distributions Received From Cooperatives.

Bank 
Secrecy Act

Due to new U.S. Treasury Department regulations, all Bank Secrecy Act (BSA) forms 
must be completed online. This includes the FBAR, Report of Foreign Bank and Financial 
Accounts (formerly known as Form 90-22.1). In Drake, screen FBAR (or screen 9022) 
contains a link to the Financial Crimes Enforcement Network’s BSA e-Filing System’s 
website.

Before You Start

Actions you might need to take before starting an 1120S return in Drake include:

• Updating a prior-year return (if you prepared the tax return last year)

• Electing as an S corporation (if the corporation was not an S corporation last year)

Updating a Prior-Year Return in Drake

A prior-year return can be updated in three ways:

• As a single return (updated one at a time) using Last Year Data > Update Clients 
2012 to 2013 (recommended) 

IMPORTANT
Allow yourself time to read and understand all the infor-
mation available on the BSA website and to register as a 
BSA e-filer.
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• When you open the return for the first time in the 2013 program and are prompted 
to update it

• With all other returns in the program using Last Year Data > Update Clients 
2012 to 2013 (not recommended)

When you update an 1120S return that was previously marked as “final,” the program 
informs you that the return was marked final before prompting you to proceed.

Indicating an S Corporation

If the corporation is electing as an S corporation for the first time, it is necessary to 
indicate this in the program.

S Corp 
Election

On screen 1 in the General Information section, line A, enter the date of election as 
an S corporation. On line E, enter the date incorporated.

Form 2553, Election by a Small Business Corporation, is required if the entity is mak-
ing the election with the return. In Drake, use screen 2553, accessible from the Other 
Forms tab or by clicking the Form 2553 link on screen 1.

Changing 
File Type

To change a “C” corporation to an S corporation (1120 to 1120S):

1. Go to Tools > File Maintenance > Change File Type.

2. Enter the EIN of the entity.

3. Click Continue.

4. Select the new return type (Sub-S Corp 1120S).

5. Click Continue to save changes.

6. Click OK.

Other Information and Overrides

Use screen 1 to enter the following additional information:

• Resident State — If the corporation has a mailing address in one state but does 
business in another, select the state in which the corporation does business from 
the Resident State drop list.

• Drake Codes and Overrides — Screen 1 includes fields for miscellaneous 
codes, invoice numbers, and several overrides. See “Listing a Different Firm, Pre-
parer, or ERO on a Return” in Chapter 2 and “Miscellaneous Codes” in Chapter 5 
of Drake Software User’s Manual: Tax Year 2013 for more information.

NOTE
If attaching a signed Form 2553 to the return as a PDF, mark the 
Attaching Form 2553 as a PDF document box on screen 1. If not sent 
as a PDF, the form must be mailed separately to the IRS before filing 
the tax return. See Form 2553 instructions at www.irs.gov.
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Header Information

Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1120S.

Name and Address

Use screen 1 to complete the corporation name and address section of Form 1120S. 
For state purposes only, if the corporation has an alternate address (such as a P.O. 
box), you can enter that address on screen 2, in the Address Line 2 field at the bottom 
of the screen. (Access screen 2 from the States tab, or enter 2 in the selector field and 
press ENTER.) 

Tax Year

The software uses the calendar year as the default period for all corporate returns; no 
date entries are required on screen 1 for a December 31 tax year end.

Fiscal and 
Calendar 

Years

If the S corporation uses a fiscal year (where the year begins in the current calendar 
year and ends in the next), specify the beginning and ending dates in the If not calen-
dar year section of screen 1.

Short-Year 
Returns

An entity may have a short-year return if changing accounting periods with IRS 
approval (Form 3115), or if this is its first or last year in business and the tax year is 
not a full year.

To indicate a short-year return, use the fiscal year date fields on screen 1 to indicate 
the beginning and ending dates for the current year. (These fields should not be used if 
the entity is filing a full calendar-year return.)

If filing a short-year return (other than an initial or final return), you will need to pro-
vide an explanation. To do so, go to the ELEC screen (accessible from the Miscella-
neous tab) and select an explanation from the Other short year reason drop list. The 
explanation will be displayed at the top of the first page of the tax return. If you do not 
select an explanation, an EF message will be generated with the return and the return 
will not be eligible for e-file.

NOTES
The program adjusts calculations for depreciation and for gains and 
losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53–week year, see “Electing a 
52-53–Week Year (Initial Return)” on page 40.

NOTES
For more information on short-year explanations, see IRS Pub. 
4163.

The program may not correctly calculate depreciation, gains, or 
losses for a short-year return. Depreciation for a short-year return 
can be entered on screen 4562 and screens 6, 7, 8, and 9.
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Boxes A through I

Enter most information for boxes A through I (top of Form 1120S) on screen 1. Note 
that boxes C (“M-3 attached”) and F (“Total assets”) are completed automatically by 
the program based on data entered elsewhere. Other boxes are:

• Box A — S election effective date

• Box B — Business activity code (From screen 1, choose a code from the line B 
drop list, or click in the line B field and press CTRL+SHIFT+S to search for a code)

• Box D — Employer Identification Number (EIN) (program uses setup data as 
default)

• Box E — Date incorporated

• Item G — Indicates first year as S corporation and inclusion of Form 2553 with 
return

• Item H — Check boxes for final return, name change, address change, amended 
return, and S election termination or revocation

• Item I — Number of shareholders during the year (completed automatically based 
on the number of K-1s; number can be overridden on line I of screen 1.)

Income and Deductions

Income and deductions are entered primarily on the INC (Income and Common 
Schedule K Items) and DED (Deductions) screens.

Gross Receipts

Enter gross receipts or sales (Form 1120S, line 1a) and returns and allowances (line 
1b) on the INC screen.

The program calculates gross receipts or sales after returns and allowances based on 
gross receipts, sales, and any direct entry on line 1b.

NOTES
Enter accounting method at the bottom of screen 1.

The Client information fields at the bottom of screen 1 are for 
reports only and not included in the e-file record.

NOTE
For information on the Schedule K items at the bottom of the INC 
screen, see “Schedule K: Shareholders’ Pro Rata Share Items” on 
page 20.

NOTE
The IRS does not require a detail (Ctrl+W) worksheet for gross 
receipts; therefore, if you are using the trial balance import feature, do 
not include a detail worksheet for this line—or for any other line that 
does not require a detail worksheet. For more on the trial balance 
worksheet, see “Importing Trial Balance Information” on page 45.
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Cost of Goods Sold (Form 1125-A)

For cost of goods sold (COGS), complete screen A (Form 1125-A, Cost of Goods 
Sold).

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3 (“Inventories”). Note that the Inventories fields on screen L (Assets, 
Liabilities and Equity) are overrides. Anything entered there overrides the inventory 
data that flows from screen A.

Line 5, Other 
Costs

Line 5 of Form 1125-A is designated for any applicable costs not entered on the previ-
ous lines. In Drake, two fields on screen A are provided for line 5: one for other costs 
excluding depreciation, and one for depreciation (Figure 4).

Figure 4: Other Costs and Depreciation

In the Depreciation field, enter any depreciation that relates to the cost of goods sold 
(unless the amount is flowing from the 4562 Detail screen with COGS selected from 
the For drop list). (Note that this field on screen A is an override field; an entry here 
overrides the calculations from the 4562 screen.) Amounts entered in this field auto-
matically adjust the total depreciation that is carried to page 1 of Form 1120S. For 
Other costs - excluding depreciation, use a CTRL+W worksheet. The depreciation 
amount is included on the statement for other costs and should not be included in the 
Other Costs worksheet.

Importing 
Trial Balance 

to Form 
1125-A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 45), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not into the fields in data entry. When the trial balance is imported, 
the COGS depreciation expense amount flows directly to the appropriate line of Form 
1125-A and is calculated accordingly.

Ordinary Gains and Losses

The amount on line 4 (“Net gain (loss) from Form 4797, Part II, line 17”) of Form 
1120S flows from Form 4797. Amounts can also flow from screen 4562, but only if 
that screen shows assets sold and property type.

NOTE
On screen A, items 9a through 9f are direct-entry fields and follow the 
format of IRS Form 1125-A. For more information on completing 
these fields, press F1 or consult the IRS instructions.

NOTE Line 14b on the DED screen is for Form 4562 depreciation that is not 
entered on screen A or elsewhere on the return.
Tax Year 2013 7



Income and Deductions Drake Software User’s Manual Supplement: S Corp
Other Income (Loss)

Enter all amounts for line 5, Other income (loss), on the INC screen. INC screen data 
is displayed on attached statements in View mode.

Amounts from the following screens also flow automatically to line 5:

• 6478 (Form 6478, Alcohol and Cellulosic Biofuel Fuels Credit)

• 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)

Additional fields on the INC screen include:

• Amount of credit for tax on fuels

• Interest income on receivables

• Recoveries of bad debts

• Section 481 adjustments

• State tax refund

• Income from insurance proceeds

To enter income or loss from a partnership, estate, or trust, use screen K1P or K1F. 
(Click the screen links on the INC screen or access them from the Other Forms tab). 

To enter additional sources of income not shown, create a CTRL+W worksheet using 
the Other Income (itemize) field on the INC screen.

Compensation and Wages

Enter shareholder compensation and employee wages on the DED screen. Drake has 
two fields each for officer compensation and employee salaries/wages: one for non-
shareholders, and one for shareholders.

Credit 
Adjustments

A credit adjustment is made for the following forms:

• Form 5884, Work Opportunity Credit

• Form 8844, Empowerment Zone and Renewal Community Employment Credit

• Form 8845, Indian Employment Credit

The adjustment is indicated on Form 1120S with the ATT_SSW literal. (Figure 5 on 
page 9). Actual adjustments are shown on the ATT_SSW worksheet in View mode.

NOTES
The Salaries and wages to non-shareholders field is an adjust-
ment field. An amount entered here is combined with any amount 
entered in the Labor hired field on screen F.

The shareholder fields are used for calculating section 179 income 
limitations; see the WK_S179L worksheet in View mode.
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Figure 5: ATT_SSW literal on Form 1120S

Compensation of Officers (Form 1125-E)

New for 2013: Form 1125-E, Compensation of Officers is not generated automatically 
with the return unless it is required—in other words, unless total receipts (lines 1a 
through 6) on Form 1120S are $500,000 or more., and officer compensation is being 
reported in the return. To force the software to print Form 1125-E, from the PRNT 
screen, select Force Form 1125-E, Officer Compensation.

 Officer 
Information

Use screen E to enter officer information and compensation amounts. Press PAGE 
DOWN to enter additional officers. Screen E totals are calculated and carried to line 7 
of Form 1120S.

The total of officer compensation can be entered in the Officer Compensation over-
ride field on the DED screen (generally used when Form 1125-E is not required). An 
entry in that field overrides any calculations from screen E, changing lines 12 and 27 
of the 1120 but not Form 1125-E.

Screen E 
Check Boxes

Screen E has two check boxes: Signs return, and Books in care of. Mark the applica-
ble box on the screen that identifies the officer who either signs the federal or state 
paper returns, or is the contact person for the books (state return only; does not affect 
the federal return unless there is no PIN screen).

Ownership & 
Participation

The Ownership and Participation fields on screen E are required. Fields are as fol-
lows:

• Total — Enter the officer’s ownership percentage.

• Common — Enter the percentage of common stock owned by the officer.

• Preferred — Enter the percentage of preferred stock owned by the officer.

• Time — Enter the percentage of time the officer devotes to the corporation.

Enter percentage amounts in whole numbers. For example, enter 40 for 40%.

Repairs and Maintenance

Enter repair and maintenance costs on the DED screen. An amount entered there is 
combined with the amount, if any, entered in the Repairs and maintenance field on 
screen F.
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Bad Debts

Use the Bad debts field on the DED screen to enter the total debts that became worth-
less in whole or in part during the year, but only to the extent that such debts related to 
a trade or business activity.

Rents

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the corporation rented or leased a vehicle, enter the total annual rent or 
lease expense incurred in the trade or business activity of the entity, and then complete 
Part V of the 4562 (screens 8 and 9). 

Taxes and Licenses

Enter tax and license amounts on the DED screen. Amounts are combined and the 
sum generated on Form 1120S, line 12 (“Taxes and licenses”). Note that credit from 
Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain 
Employee Tips) should be entered on screen 8846, which is accessible via a link from 
the DED screen. These amounts also appear on the “Taxes and Licenses Attachment,” 
referred to on line 12 with the printed “ATT_STL” reference. (Figure 6.)

Figure 6: Notification on line 12 of the 1120S return that the
Taxes and Licenses attachment has been produced with the return.

To keep the notification from appearing on line 12 of the return, go to the PRNT 
screen and select Suppress printing of form and attachment references.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen are carried to the tax computation (ATT_TAX) worksheet. The state tax 
amount carried from the ES screen may differ depending on which method of 
accounting (cash or accrual) is used.

NOTES
Enter deductible non-business bad debts as a short-term capital 
loss on screen 8949 (Sales and Other Disposition of Assets).

Cash-method S corporations cannot take a bad debt as a deduc-
tion unless the amount was previously included in income.

NOTE
The Rents field is an adjustment field. An amount entered here is 
combined with the amount, if any, entered in the Rent fields on 
screen F.
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Interest

Using the 1120S instruction guidelines, enter interest expense on the DED screen. 
Note that the Interest expense field is an adjustment field. Any amount entered here 
is combined with the amount, if any, entered in the Interest fields on screen F.

Depreciation

Enter depreciation on the 4562 screen. Select a form from the For drop list to associ-
ate the depreciable item with the correct form or activity. Data from the 4562 screens 
is calculated and carried to Form 1120S and/or to the selected schedules or forms.

For more information on depreciation and the 4562 screen in Drake, see the Drake 
Software User’s Manual: Tax Year 2013.

Line 14, 
Depreciation

Line 14 of Form 1120S is reserved for depreciation that (1) is from Form 4562, and 
(2) is not claimed on Form 1125-A or elsewhere. While the program pulls data from 
the 4562 screen for this line, it also provides field 14b on the DED screen specifically 
for depreciation that is claimed elsewhere.

Both lines 14a and 14b on the DED screen are adjustment fields.

• Line 14a — See field-level help for further instructions and information on 
how this field ties in to Form 4562.

• Line 14b — Drake recommends entering depreciation on the 4562 screen, 
and then selecting COGS from the For drop list at the top of the screen. You 
can also use screen A (rather than the DED screen) to enter depreciation 
claimed on Form 1125-A. An entry on screen A adjusts any entry on line 14b 
of the DED screen and is calculated into the total deductions for page 1 of 
Form 1120S. If there is an entry on line 14b but not on screen A, only the line 
14b amount will be calculated into total deductions.

Depletion

Enter depletion amounts on the DED screen. If the corporation claims a deduction for 
timber depletion, complete and attach Form T, Forest Activities Schedules. (Attach as 
PDF to e-filed returns. (See “The PDF Attachment Process” on page 42.) Do not 
deduct depletion for oil and gas properties. (Each shareholder should figure depletion 
on these properties under section 613A(c) (11).)

Advertising

Enter advertising expenses on the DED screen.

Pension and Profit-Sharing

Enter pension and profit-sharing expenses on the DED screen. Press F1 for informa-
tion on what expenses to enter. The software reduces the expense based on the credit 
amount calculated from Form 8881, Credit for Small Employer Pension Plan Startup 
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Costs. Note that this is an adjustment field; the software uses any amount entered here 
to adjust the amount flowing from Schedule F to the 1120S.

Employee Benefits Program

Enter on the DED screen amounts for fringe benefits paid or incurred on behalf of 
employees owning 2% or less of the corporation’s stock. Do not include with these 
amounts anything that is an incidental part of a pension, profit-sharing, etc., plan or 
amounts reported elsewhere on the return.

Report amounts paid on behalf of more than 2% shareholders on line 7 (“Officer com-
pensation”) or 8 (“Salaries and wages”), whichever applies. A shareholder is consid-
ered to own more than 2% of the corporation’s stock if that person owns, on any day 
during the tax year, more than 2% of the outstanding stock of the corporation or stock 
possessing more than 2% of the combined voting power of all stock of the corpora-
tion.

Note that the field for line 17 is an adjustment field. An amount entered in here adjusts 
the amount flowing to Form 1120S from Schedule F, line 17.

Other Deductions

Enter all other deductions on the DED screen. Drake incorporates the total into line 
19, “Other deductions,” on Form 1120S.

The following deductions, credits, adjustments, and exclusions also flow to line 19:

• Amortization from Form 4562

• Credit adjustment from Form 8820, Orphan Drug Credit

• Exclusion from Form 8873, Extraterritorial Income Exclusion

• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Tax and Payments

Screen 4 has fields for completing the “Tax and Payments” section of Form 1120S. 
Note that some fields are overrides. Press F1 to view more information on a field.

Net Passive Income

Line 22a, “Excess net passive income or LIFO recapture tax,” could apply to an S cor-
poration if it was formerly a “C” corporation or if it engaged in a tax-free reorganiza-
tion with a “C” corporation.
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To determine if the corporation must pay the tax, complete the worksheet fields on the 
lower half of screen 4. If completing the IRS worksheet, enter the worksheet results on 
screen 4. Enter LIFO recapture directly on screen 4.

Schedule D

Use screen 8949 to enter capital gains and losses. The net gain from screen 8949 is 
carried to lines 7 and 8 of Form 1120S, page 3, Schedule K. Use screen 8949 to enter 
data for Parts I and II of Schedule D (Form 1120S), Capital Gains and Losses and 
Built-in Gains. Use the DTAX screen for Part III, “Built-in Gains,” of Schedule D 
(Form 1120S). For information on using the Schedule D import feature in Drake, see 
“Schedule D Imports” in Chapter 5 of the Drake Software User’s Manual: Tax Year 
2013.

Estimated Tax

The 1120S does not have a federal estimated tax voucher. Estimated tax payments are 
required only in certain situations. An S corporation must make electronic deposits of 
employment, excise, and corporate income taxes using the Electronic Federal Tax 
Payments System (EFTPS).

Use the ES screen (available from the Miscellaneous tab or from a link on screen 4) 
to enter federal and state estimated taxes paid in 2013. If the return was updated in 
Drake from 2012, this information is carried over. Note that this information will be 
overridden by any entry in the Current-year estimated tax payments field on screen 
4.

Use the ES screen for 2014 estimated payments. Future year amounts appear on the 
ES_SUM worksheet generated with the return. To enter the amount to be credited, use 
the OP to 2014 field. Note that this information will be overridden by any entry in the 
Amount to be credited to next year’s estimated tax field on screen 4.

Payments with Extensions

To make a payment with an extension request, enter the amount being paid in the 
Amount paid with extension field at the bottom of the 7004 screen (available from 
the Other Forms tab or from a link on screen 4). If an extension was previously 
requested and a payment was made then, enter the amount paid on screen 4, line 23b.

Tax Paid on Fuels

Use screen 4136 to enter information for Form 4136, Credit for Federal Tax Paid on 
Fuels. Note that this screen consists of two screens, with lines 1 through 8f on the first 
screen. Press PAGE UP or PAGE DOWN to go from screen to screen.

NOTE To force the line 22a worksheet to be printed, select the applicable 
box on screen 4.
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Underpayment of Estimated Tax

For underpayment of estimated tax, complete all applicable fields on screen 2220. 
(Note that this screen also consists of two screens.)

Direct Deposit of Refunds

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submit-
ted with an e-filed return in order for a corporation’s refund to be directly deposited. 
To complete this form in Drake, use the DD screen (Figure 7).

Figure 7: Federal section of DD screen (also 8050 screen)

When filling out the DD screen:

• If the federal refund is to go to the account listed, select Yes for the Federal 
Account selection; otherwise, select No. (Default is Yes.)

• If a state refund is to go to the account listed, select the state abbreviation from the 
State/city selection drop list.

• Enter the name of the financial institution, the routing number (RTN), the account 
number, and the type of account (Checking or Savings).

• Re-enter the RTN, account number and type of account to verify.

If receiving refunds from different state tax authorities, use the State Account sec-
tions on the DD screen to indicate where other state refunds should be deposited.

International ACH Transactions

In 2009, state taxing agencies added foreign account questions to their forms to com-
ply with NACHA rules regarding International ACH transactions (IAT); however, 
processing IAT is not yet supported by any federal or state tax authority. If you were to 
indicate that the account was outside the U.S., the state tax authority would automati-
cally ignore the account information and either issue a refund via paper check, or con-
tact the corporation requesting the payment of a balance due via check or domestic 
bank account. If you indicate that an account is located outside of the U.S., Drake 
Software generates an EF message instructing you to choose an account located in the 
U.S.

For more information, see Screen Help on the DD screen and PMT screens.

Electronic Funds Withdrawal (Direct Debit)

Use the PMT screen, accessible from the General tab, to indicate that the balance due 
for an e-filed return should be withdrawn (direct-debited) from an account.
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Program Defaults and Overrides

By default, the program indicates that the entire balance due (the “Amount owed” line 
of Form 1120S) is to be withdrawn on the return due date. To indicate otherwise, com-
plete the Requested payment date override field for the applicable payment.

If the return is e-filed on or before the due date, the requested payment date cannot be 
later than the due date. If the return is transmitted after the due date, the requested pay-
ment date cannot be later than the current date.

Required Information

A Withdrawal selection (item 1 in Figure 8) is required if the program is to direct tax 
authorities to withdraw funds from the taxpayer’s account.

Figure 8: Required fields on PMT screen: withdrawal selection (1);
account information (2); specified return (3)

The name of the financial institution, routing number (RTN), account number, and 
account type are required. As with the DD screen, the RTN, Account number, and 
Type of account data must be entered twice (item 2 in Figure 8).

Finally, the PMT screen must indicate the return to which the payment data applies 
(item 3 in Figure 8). Put a check mark in the box of the applicable return type.

Withdrawal from Multiple Accounts

Only one account can be designated for direct debit of funds for payment of federal or 
state taxes. To have state amounts withdrawn from an account other than the account 
indicated for federal payments, complete the fields in the State Account sections of 
the PMT screen. 

Filing an Extension

Calendar year returns are due on March 17, 2014. By filing Form 7004, an S corpora-
tion can extend the deadline six months to September 15. Fiscal year returns are due 

NOTE Neither the federal nor the state balance due can be paid from more 
than one account.
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on the 15th day of the third month after the end of their tax year. Form 7004 extends 
the deadline six months.

To file an 1120S extension, use either of the following options:

• Go to the 7004 screen in Drake and select Generate an extension. Complete any 
other applicable fields on the screen.

• Go to the PRNT screen and select Prepare Form 7004 based on screen 1 data.

Signing the Return

Electronic (PIN) <is there a reason for that to be in parenthesis?< signatures are 
required for e-filed returns. All fields on the PIN screen must be completed to e-file a 
return, including the title and signature (name) of the officer signing the return. 

An 1120S return must be signed and dated by one of the following individuals:

• The corporation’s president, vice president, treasurer, assistant treasurer, or chief 
accounting officer

• Any other corporate officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required 
information on the PIN screen. If it is prepared by an employee or officer of the cor-
poration, open screen 1 and select NONE in the Firm # and Preparer # fields.

To have the preparer’s name and address information displayed on the printed return:

• If the return preparer and ERO (entered in Setup > ERO) are the same:

– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.

– Complete the PIN screen for the return.

• If the return preparer and ERO are not the same:

– Go to the PRNT screen for the return and complete the field labeled PIN for 
preparer’s alternative electronic signature. The PIN entered should match 
the one entered for the preparer in Setup > Preparer(s). (For more informa-
tion, press F1 in this field.)

NOTE
Setup > ERO must still be completed for e-filing. For information on 
how to complete this setup window, see Drake Software User’s Man-
ual: Tax Year 2013. See the IRS instructions for further details on sig-
nature requirements.
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Amending a Return

Amended 1120S can be e-filed using Drake Software.

To file an amended 1120S return:

1. Go to screen 1 and select Amended return in section H.

2. Make changes as applicable to forms and schedules.

3. Go to the EF screen and mark the Amended 1120S check box on the left side of 
the screen.

Type AMD or X 
into the selector 
field and press 
ENTER.

4. Go to the AMD (or X) screen and list the changes that have been made, along 
with an explanation for each change. Use a different AMD screen for each line of 
the 1120S. Press PAGE DOWN to open a new AMD screen.

If amending just the K-1s, go to each applicable K1 screen, select Amended K1, and 
make needed changes.

Additional Information

This section covers Schedule B (Other Information), state-specific information, and 
some program overrides.

Schedule B

Enter the accounting method, principal business activity, and product or service on 
screen 1. This information flows to lines 1 and 2 of Schedule B.

New for 2013: Use screen B to answer questions 3 through 13b of Schedule B.

If the answer to question 3 is “Yes,” complete screen B1. If the S corporation owned, 
directly, 20% or more, or owned directly or indirectly 50% or more of the total stock 
issued and outstanding of any foreign or domestic corporation, click the B4A Screen 
link on screen B to enter information about the domestic or foreign corporation 
owned. (You can enter information for up to 10 lines corporations per B4A screen; to 
add more, press CTRL+PAGE DOWN.)

If the S corporation owned, directly, 20% or more, or owned, directly or indirectly, 
50% or more in the profit, loss, or capital in any foreign or domestic partnership 
(including an entity treated as a partnership), or in the beneficial interest in a trust, 

CAUTION
When you amend a return in Drake, the amended information 
replaces the original in the data file. Before amending a return, 
you should archive the original to avoid losing previously sub-
mitted data. For more information on archiving returns, see 
“Archive Manager” in Chapter 6, “Return Results,” of the Drake 
Software User’s Manual: Tax Year 2013.

NOTE
When amending an 1120S return, all K-1s are amended and the 
“Amended K-1” box on the return marked by default. To override this 
default, go to the PRNT screen and mark Do NOT check amended 
box on Sch. K-1. (See Figure 10 on page 22.)
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click the B4B Screen link on screen B to enter information about the domestic part-
nership owned. (You can enter information for up to 10 partnerships per B4B screen; 
to add more, press CTRL+PAGE DOWN.)

State-specific Information

Resident 
State

The program automatically generates a return for the corporation’s resident state. Use 
screen 2 to enter company information as it should appear on the state return.

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group, multi-state) and state-specific dates and num-
bers for identification.

Other States Data for other states must be entered manually in state data entry. To access state data 
entry, select the States tab from the Data Entry Menu and choose a state, or enter the 
two-letter state code in the selector field and press ENTER.

Multi-State 
Appor-

tionment

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment 
screen (Figure 9 on page 19). This screen provides one central location for entering all 
state apportionment information instead of having to open each needed state’s screen. 

In addition to making data input faster and easier, this feature provides two work-
sheets: a summary worksheet (SA-SUM~) that can be used for verifying input, and a 
reconciliation worksheet (SA-REC) that ties the total of the state amounts to the fed-
eral return figures. These worksheets are available in View mode.

The individual state apportionment screens will continue to be available in Drake14 
but will be used to override data entered on the APPT screen. No state apportionment-
related screens will be updated from Drake12 to Drake13.

NOTES
The company information fields on screen 2 apply for the resident 
state only.

Click the screen 2 link from the States tab or enter 2 in the selector 
field and press ENTER.
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Figure 9: APPT Multi-State Apportionment screens

APPT Screens The APPT screen is opened to the Sales tab. Links at the top of this screen take you to 
the Payroll, Property, and Additional Property tabs for each state selected 
(Figure 9). These screens and their uses are listed in Table 1:

You may enter up to four states on one APPT screen. If you need more than four 
states, press PAGE DOWN for a new APPT screen. The same state can be entered more 
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the 
reconciliation worksheet. Not every item appearing on the federal return may be sub-
ject to multi-state apportionment. When you select OT, the data entered becomes a 
reconciling adjustment amount to aid in tying to the federal return. 

NOTE
Mark the Zero Apportionment check box (Figure 9) to add a state 
but not include any apportionment data. This will include the state 
on the apportionment summary worksheet (SA-SUM~), available 
through View mode.

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state

Payroll Enter salary, wage, commission, and labor amounts for 
each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, plus select additional apportionment factors 
from drop lists

Additional Property Select additional apportionment factors from drop lists

NOTE
The Ending amount entered on the Property and Addition Property 
screens in Drake13 will become the Beginning amount for property 
on the APPT screen when the client’s return is updated next year in 
Drake14.
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Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information will flow to that state’s return.

Contact 
Information

If certain contact information required for state purposes is different from that entered on 
screen 1, use screen 2 for the alternative data for any of the following entities:

• Registered office

• Principal place of business

• “Books in care of” information

Screen 2 also has fields for the name, title, mailing address, e-mail address, ID num-
ber, and telephone number of the S corporation’s contact person.

Access screen 2 from the States tab or by entering 2 in the selector field and pressing 
ENTER.

Schedule K: Shareholders’ Pro Rata Share Items

Screen K, which consists of two screens, can be used to enter data for Schedule K, 
Shareholders’ Pro Rata Share Items. Note that the K fields are primarily adjustment 
fields. Press F1 inside a field to see what amounts are adjusted from elsewhere in the 
program.

Navigation

Press PAGE UP and PAGE DOWN to navigate back and forth between the two K 
screens:

• Shareholders’ Pro Rata Share Items (Income and Deductions)

• Credits & Credit Recapture & Foreign Transactions 

NOTES

You can find information on adjustment and override fields through 
the FAQ screen. Open the FAQ screen, click the Screen Help but-
ton (or press CTRL+ALT+?) and click the links at the top of the win-
dow. An Internet connection and Adobe Reader are required in 
order to view the worksheets.

Much of the information contained in the worksheets is also avail-
able from the field-level helps within the program. To access a field-
level help, click inside a field and press F1, or right-click in a field 
and select Help > Help for this Field.

TIP
The most commonly used Schedule K items can be answered on the 
INC screen. If these amounts are entered on the INC screen, they do 
not need to be entered on the K screens.
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Schedule K-1 for 1120S (Shareholder Information)

Use the K1 screen to enter data for Schedule K-1, Shareholder’s Share of Income, 
Deductions, Credits, etc.

Ownership Changes

Ownership changes are entered on the OWN screen, which is accessible through the 
OWN Screen link on line F of the K1 screen or from the General tab of the Data 
Entry Menu. To use the OWN screen:

• Enter the date of ownership change at the top of the screen.

• Select the applicable shareholder from the drop list in the Change in Shares sec-
tion. (The drop list consists of the names and ID numbers entered on the K1 
screens and is updated automatically).

• Enter the change in ownership as a positive amount for an increase and a negative 
amount for a decrease. (See field-level help for more information.)

• To enter additional ownership changes, press PAGE DOWN.

Printed Data A Summary of Stock Ownership worksheet (WK_SOWN) is generated, listing all 
shareholders and the numbers of stocks owned along with the changes in ownership. 
Because a shareholder’s percentage of ownership may change even if the share-
holder’s number of stocks owned does not, all shareholders are listed on the work-
sheet.

IRS K-1 Codes

A code sheet can follow the printing of each Form 1120S K-1 to help interpret the var-
ious codes used on Schedule K-1. In Drake, this is the 1120SK_1.PG3 sheet. To have 
this sheet printed with all K-1 schedules, from the Home window of Drake, go to 
Setup > Options > Form & Schedule Options tab and mark the Print Page 2 of 
Schedule K-1 check box. The codes can also be printed for a specific return by mark-

NOTE

Because charitable contributions are separately stated to the share-
holders, there is no “Charitable Contributions” line on the 1120S 
return. Charitable contribution information belongs instead on the 
Schedule K. Enter charitable contributions in the bottom section of 
the INC screen or in the line 12a - Contributions fields of the K 
screens. Any contribution limitation is made at the shareholder level.

NOTE
The program calculates percentage ownership based on the number 
of shares owned. (This amount can be overridden on line F of the K1 
screen, using the Shareholder’s % of stock ownership field; how-
ever, this not recommended.)

NOTE See FAQ item “P” in the program for more information on entering 
ownership-change information.
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ing the applicable box on the PRNT screen, and are available from Tools > Blank 
Forms. 

The generated Schedule K-1 may include asterisks with letter codes:

• An asterisk with a letter code indicates that multiple items have that code.

• An asterisk at the bottom of a group indicates that there are more items than can fit 
in the space provided for that group and that a statement is attached, or that the 
statement is required (as in the case of “other” amounts).

Multiple Shareholders

For returns with a large number of shareholders, you have the option to deactivate cal-
culation and printing of the K-1s while working on the Form 1120S. This option, 
which eases the process of reconciling the 1120S, is available by going to the PRNT 
screen and marking the box under K-1 Items to Suppress (Figure 10).

Figure 10: Check box for suppressing K-1 items (located on PRNT screen)

When the return is ready to be filed, return to the PRNT screen and remove this check 
mark before calculating the return.

Override Fields

It is not possible to override the calculations for a single shareholder. To override cal-
culated data, it is necessary to override the calculated amount on all K-1 schedules.

Foreign Addresses 

If the shareholder has a foreign address, enter Province/state, country, postal code 
information on the Foreign address line of the Shareholder Name and Address 
Information section (along with the street address and city in the Address and City 

NOTE
Codes sheets are not displayed in View mode. If the 1120S K-1 is 
selected for printing, it is printed first, followed by the statements per-
taining to that 1120S K-1. These are followed by the code sheets.

IMPORTANT
Shareholder overrides should not be done for an S cor-
poration except in certain circumstances, such as owner-
ship changes.
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fields). Do not enter anything in the U.S. State or ZIP fields. Conversely, for a U.S. 
address, do not enter anything into the foreign address fields.

K-1 Export

Take the following steps to export a K-1 from an 1120S return into a 1040 return:

1. Ensure that K-1 data is entered in the 1120S and that the 1040 return has been cre-
ated. (The K1S screen in the 1040 does not have to be created beforehand.)

2. In the 1120S return, go to View mode.

3. Click K1 Export in the View toolbar. If any K-1s are not eligible to be exported, 
that list appears. Click Next to continue; otherwise, the Export K1s window is 
opened, containing a list of K-1s eligible for export.

4. All SSNs in the list are eligible for export. Remove the check mark from the box 
to the left of any SSNs you do not wish to export.

5. Click Export. The K-1 data will be displayed in the 1040 return in the program.

Supplemental Info

Two types of supplemental information can be added to Schedules K-1:

• Supplemental data for all K-1s in a return

• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s), from the Data Entry 
Menu, open screen K1G (Global Supplemental Information) and enter the informa-
tion in the Supplemental Information text box. This information will appear on all 
printed shareholder K-1s.

To add supplemental information to an individual K-1, open a shareholder’s K1 
screen and click the blue Supplemental Info link at the top of the window. In the 
Supplemental Information pane (Figure 11 on page 24), enter information pertinent 
to this shareholder. When the return is printed, this information will appear on only 
this shareholder’s K-1.

NOTE
The Foreign fields are locked when a return is opened. Click in one 
of the fields to unlock them throughout the return. To relock the 
unused Foreign fields, close and then reopen the return.

NOTE
Basis information for individual shareholders should be entered in the 
1040 package in Drake; this information cannot be exported from the 
1120S package to a 1040 return. Such an import would override lim-
itations and carryovers calculated in the 1040 program.
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Figure 11: In this example, the information entered on the K1S screen will appear
 on only the individual shareholder’s K-1.

Domestic Production Activities

An S corporation does not take the deduction for Form 8903, Domestic Production 
Activities Deduction. Because the deduction is subject to income limitations, this 
information must be reported on shareholders’ individual returns. Shareholders use 
the pass-through amounts to calculate their eligibility for the deduction.

On the 8903 screen, if the Print K1-8903 for each shareholder box is not selected, 
the amounts flow to the K-1, box 12, with codes Q and R. When this box is selected, 
the information flows to attachment K-1_8903 (Figure 12) instead of box 12 on the K-
1. Attachment K1_8903 is referenced on a statement. Code P is printed on box 12 of 
Form K-1, which refers to domestic production activities information.

Figure 12: K1_8903 attachment

Review the screen-level help on screen 8903 and the 8903 instructions (accessible 
through the Screen Help button on the 8903 screen) to determine when the K1_8903 
in needed.

NOTES

Line 11,“Income limitation,” of Form 8903 is not applicable for the
S corporation because the income limitation is calculated at the 
shareholder level.

“Form W-2 wages” (on the 8903 screen) refers to the corporation’s 
W-2 wages paid that are applicable to the Domestic Production 
Activities Deduction.
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K-1 Cover Letters

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You 
can set up the global option to produce K-1 cover letters for all returns containing K-1 
schedules, or you can choose the option on a per-return basis.

Producing 
Letters for 

All Returns

To have the K-1 cover letters produced automatically with all applicable returns, from 
the Home window of Drake, go to Setup > Options. Under the Optional Documents 
tab, mark the box labeled Include K-1 letter with returns.

The signature on the return can be indicated in one of two ways:

• By completing the Signature and Title fields on the PIN screen

• By completing the Name and Title fields in the K1L screen (available on the 
Miscellaneous tab). Entries here override entries on the PIN screen.

Producing 
Letters for 

Single 
Return

If no default has been set to produce K-1 cover letters with all returns, you can take the 
following steps to generate letters for a single return:

1. Open the return and go to screen K1L.

2. At the bottom of the screen, enter the name and title of the person who will be 
signing the K-1 cover letter.

3. (optional) Mark Do not print entity information ... at the bottom of the screen in 
order to prevent the corporation’s name and address from being generated in the 
header of the K-1 letter.

Once the required signing information has been entered, a K-1 cover letter will be 
generated for each shareholder receiving a K-1.

Editing the 
K-1 Letter

As with other letters provided by the program, you can edit the text to suit your office 
needs and style.

To edit the text of the K-1 letter:

1. From the Home window, select Setup > Letters. The Client Communications 
Editor is displayed.

2. Select Open > S Corporation > Sub S K-1 Cover to view the template of the 
S corporation K-1 letter.

3. Make any desired changes to the template.

NOTE
To have the corporation’s name and address generated for K-1 let-
ters, go to Setup > Letters > Setup > Letterhead, Margins and 
Borders and select Use letterhead on letters. The letterhead is 
derived from information entered on screen 1.

TIP
Review the following sections of the Drake Software User’s Manual: 
Tax Year 2013 before making changes to letter templates:

- “Introduction to Letters in Drake” in Chapter 2, Installation & Setup

- The “Letter Keywords” section of Appendix B, Keywords
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4. Click Save.

Shareholder’s Adjusted Basis Worksheet

Use the Shareholder’s Adjusted Basis Worksheet (Basis Wks screen) to calculate a 
shareholder's new basis after increases and decreases are made during the current year. 
The basis of S corporation stock is adjusted on an ongoing basis (unlike for a “C” cor-
poration, where stock basis remains constant unless additional stock purchases are 
made or stock is sold). A shareholder’s beginning basis in S corporation stock is the 
original capital contribution.

The Basis Wks screen is accessible by clicking the Basis Wks tab at the top of the K1 
screen for a shareholder (Figure 13). (Access the K1 screen from the Data Entry 
Menu.)

Figure 13: K1 screen tab for accessing the Adjusted Basis Worksheet

Increases 
and 

Decreases

Increases to basis can include additional stock purchases and capital contributions, 
separately stated income (including tax-exempt income), and depletion in excess of 
basis of property.

Decreases to basis can include distributions of cash or property to shareholders, sepa-
rately stated losses and deductions, nondeductible corporation expenses, and credit 
adjustments.

Annual 
Update of 

Shareholder 
Information

When the program is updated to the next tax year, the end-of-year basis and share-
holder loan amounts are automatically updated to the beginning of the new year. Any 
loss/deduction carryover is updated to the beginning of the year and its character 

NOTE
For an amended return, the K-1 letter automatically refers to the 
amended K-1. To edit the letter for an amended K-1, select Open > 
S Corporation > Sub S K1 Amended and follow steps 3 and 4 of the 
previous procedure.

NOTE
Basis information for individual shareholders should be entered in the 
1040 package in Drake; this information cannot be exported from the 
1120S package to a 1040 return. Such an import would override limita-
tions and carryovers calculated in the 1040 program.
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(ordinary loss, section 179 expense, charitable contributions, etc.) maintained. The 
program also tracks the amount of debt applied to losses and the total amount of loss 
carryforwards.

Schedule L: Balance Sheet Per Books

Schedule L is required if the corporation’s total receipts for the tax year or its total 
assets at the end of the year are greater than $250,000.

Flow of Information

Many of the entries made elsewhere on the return flow automatically to the generated 
Schedule L (for example, inventory information from Form 1125-A). Depreciable 
asset information from the 4562 screen and intangible assets and amortization also 
flow to Schedule L. 

The SCH2 Screen

The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in 
Drake. In other words, if you use this screen for all applicable lines on Schedule L, 
you do not need to make any entries on the L screen.

To create a statement for a line, select a line from the drop list and enter descriptions 
and their corresponding amounts. Once the information is entered, press PAGE DOWN 
to access a new screen. If more detail is required than can fit into a Description field, 
press PAGE DOWN, and on the new SCH2 screen, select the same line number and 
then add to the description. 

Statements The total amounts entered on the SCH2 screen do not show up on the actual L screen 
in the program. They are, however, printed on the return as applicable, with references 
to the corresponding statements.

NOTE If a K1 screen is marked as final, none of the related screens for that 
shareholder are updated for the next year.

NOTES

To force the program to print Schedule L even if not required, mark 
the Force-print Schedules L and M-1 box on screen L or on the 
PRNT screen.

With the Trial Balance Import feature, you might not need to use 
screen L at all. See “Importing Trial Balance Information” on 
page 45.

NOTES
All line selections are carried to the SCH2 screen in next year’s pro-
gram when the returns are updated. Line descriptions are updated, 
with the year-end amounts carried to the beginning-of-year column.

To access the SCH2 screen from the L screen, click one of the 
SCH2 Screen links.
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The type of statement produced by the program depends on the selected line and the 
IRS requirements. If a line is required, a statement labeled “STATEMENT” is pro-
duced and is e-filed with the return. If a line is not required, a statement sheet 
(“STMT”) is produced and is not e-filed with the return.

Note that an e-fileable “STATEMENT” is referenced in the return, as shown in the 
example of Figure 14.

Figure 14: Data entered on the “Other current assets” line will be attached as an
e-fileable statement and referenced on the applicable line of the return.

SCH2 and 
Trial Balance 

Typically, one or more SCH2 detail screens are needed for Schedule L items. If you 
are using Drake’s trial balance worksheet feature, be aware that data for the SCH2 
screens cannot be entered directly into the trial balance worksheet, and it cannot be 
imported into the data entry. The SCH2 detail screens must be created apart from the 
trial balance worksheet.

When the return is produced, Schedule L reflects both the amounts imported from the 
trial balance worksheets (where direct entry was allowed) and the totals of the SCH2 
screen amounts.

For more information, see “SCH2 Detail” on page 52.

Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the unappropriated retained earnings amount on Sched-
ule L by the difference between the total assets and the total liabilities and capital 
before the adjustment.

(Example: If Assets = $1,000, and Liabilities and Capital = $900, the program 
increases the unappropriated retained earnings by $100.)

The program makes the adjustment due to differences in the balance sheet. These dif-
ferences can come from amounts entered incorrectly but are usually the result of one 
of the following causes:
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• An asset was deleted from the 4562 screen (Depreciation Detail) instead of being 
indicated as sold.

• Beginning inventory amounts were adjusted on screen A, or ending inventory 
amounts were entered incorrectly.

• Amounts were erroneously deleted from or changed on screen L.

To reconcile the differences, it is best to compare the corporation’s beginning and end-
ing balance sheet amounts for the tax year.

To deactivate the autobalance feature for a specific return, go to the PRNT screen and 
select Turn off autobalance.

Schedules M-1, M-3 (Reconciliation of Books/Return)

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are 
greater than $250,000. Schedule M-3 is required if the balance sheet’s total assets at 
the end of the year equal or exceed $10 million.

Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, taxpayers must 
reconcile book income with taxable income.

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as permanent or temporary, and as favorable or unfavorable. 
Examples of both kinds of differences are shown in Table 2.

NOTE
If the S corporation is filing Schedule M-3, and there are entries on 
the M1 screen, it’s best to delete the M1 screen. To do so, open the 
M1 screen and press CTRL+D.

Table 2: Examples Book-to-Tax Differences for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary Items that will be reported for both 
tax and book purposes, but not 
during the same tax year

- Depreciation
- Gains or losses on the sale of 

depreciated assets

Favorable Items that reduce taxable income - Instances in which tax depreciation 
amount is greater than book depre-
ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment
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Depreciation 
and 

Amortization 
Adjustments

The program may make an adjustment for book-to-tax depreciation (or amortization) 
differences. The calculation is done as described in the following steps. (This proce-
dure refers to “depreciation” throughout, but it applies for either depreciation or amor-
tization.)

1. The amount reported on Schedule L “Beginning of Year” accumulated deprecia-
tion (line 10b, column a) is subtracted from the “End of Year” accumulated depre-
ciation (line 10b, column c). This is the “book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. 
(The “tax” depreciation amount is calculated from the Forms 4562, including any 
section 179 amounts.)

3. The difference between the “book” and “tax” depreciation amounts is carried to 
the appropriate form and line.

• If the “book” depreciation amount is greater than the “tax” depreciation 
amount, the difference is carried to one of the following locations:

– Schedule M-1, line 3a

– Schedule M-3, Part III, line 24 (as a negative amount)

– Form 8916-A, line 2l (as a negative amount for assets selected on the 
4562 detail screen for COGS)

• If the “tax” depreciation amount is greater than the “book” depreciation 
amount, the difference is carried to one of the following locations:

– Schedule M-1, line 6a

– Schedule M-3, Part III, line 24 (as a positive amount)

– Form 8916-A, line 2l (as a positive amount for assets selected on the 4562 
detail screen for COGS)

Schedule M-3

Any domestic corporation or group of corporations that reports on Schedule L of 
Form 1120S total assets at the end of the S corporation’s tax year that equal or exceed 
$10 million must complete and file Schedule M-3 instead of Schedule M-1. If the 
S corporation is required to file (or voluntarily files) Schedule M-3, it must file Form 
1120S and all attachments and schedules, including Schedule M-3.

Accessing 
the M3 

Screens

The Schedule M-3 section of the Data Entry Menu provides direct access to the fol-
lowing screens:

• M3, M32, and M33 — for Parts I, II, and III of the Schedule M-3

• M3S — for supplemental statements

• SCH3 — for subsidiary schedules for Schedule M-3 and Form 8916-A

• 8916A — <that screen doesn’t exist< for Form 8916-A, Supplemental Attach-
ment to Schedule M-3
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Certain income, deductions, gains, and losses flow from the 1120S to the M-3 in the 
program, but all other M-3 data must be entered manually on the M3 screens.

The SCH3 
Screen

The SCH3 screen is similar to the SCH2 screen and is used to provide detailed infor-
mation for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3 
and 8916A ditto screens.

For more information on using this type of screen, see “The SCH2 Screen” on 
page 27.

Schedule M-2 (Analysis of Accounts)

For an S corporation return, Schedule M-2 is the analysis of the Accumulated Adjust-
ment Account. Schedule M-2 information can be entered on the M2 screen and else-
where in the program, but most information is carried to the M-2 automatically. See 
“Entering Distributions,” following.

Schedule M-2 represents a corporate picture of the income, losses, and distributions to 
shareholders and tracks tax-free distributions and helps determine if excess distribu-
tions might be taxable to shareholders. If a shareholder receives more in distributions 
than he or she has in basis, the result might be taxable.

Entering Distributions

Code Section 6037 states that an S corporation return must report the amount and date 
of distributions made to each shareholder. The DIST screen is used for entering date 
and distribution amounts for Schedule K, line 16d, Distributions. In addition to line 
16d, the total from the DIST screen may flow to Schedule M-2, line 7 (subject to lim-
itations) and to the Schedules K-1 based on the shareholder’s ownership percentage. 
Schedule K-1 distribution information is displayed on the K1_DIST worksheet pro-
duced with the return.

Column A, Accumulated Adjustments Account

The “Accumulated adjustments account” column of Schedule M-2 generally reflects 
the S corporation’s accumulated undistributed net income after 1982. Non-dividend 
distributions flow to Schedule M-2 from Schedule K, line 16d. An entry in the Non-
dividend distributions field (line 7) of the M2 screen adjusts the amount from the K 

NOTE
Parts II and III of Schedule M-3 reconcile financial statement net 
income (loss) for the U.S. tax return (per Schedule M-3, Part I, line 11) 
to total income (loss) on Form 1120S, page 3, Schedule K, line 18.

NOTE On an 1120S return (unlike an 1120 return), Schedule M-2 is not a 
reconciliation of retained earnings. 

NOTE The DIST screen is available from the General tab of the Data Entry 
Menu, or enter DIST in the selector field and press ENTER.
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screen (subject to limitations; see balance-sheet examples on the following page). See 
the field help for line 7 for more details.

Distributions reported on line 7 flow differently from the amount entered on the DIST 
screen. (See the previous section, “Entering Distributions.”) The distributions are lim-
ited following the ordering rules under Reg §1.1368.2.

These rules are for Schedule M-2, column a:

• Line 1 balance — The balance at the beginning of tax year, line 1 is either 
zero or the balance carried forward from line 8 of the previous year. Due to 
prior-year net losses and reductions, the amount on line 1 can be negative.

• Changes to AAA — The Accumulated Adjustments Account (AAA) is 
increased for ordinary income from page 1, line 21 (line 2) and other additions 
listed on line 3. The AAA is then decreased for any loss from page 1, line 21 
(line 4) and other reductions listed on line 5.

• Reduction of AAA — Once these adjustments are made, the AAA is reduced 
by ordinary distributions on line 7, but not less than zero. Thus, if the distribu-
tions are $20,000, but the net amount on line 6 is $10,000, line 7 is limited to 
$10,000. If line 6 is a negative number, then line 7 will be zero (in this exam-
ple). To allow an amount on this line would take the AAA to a larger negative 
number. (That is, even more below zero than it really is).

The rules from the preceding chart what chart? apply when the net adjustment for 
lines 2 through 5 is positive. When the net adjustment for lines 2 through 5 is negative, 
the ordering rules are switched and AAA is decreased by ordinary distributions (but 
not below zero) before the net negative adjustment for lines 2 through 5.

TIP See Form 1120S instructions for more details and examples.
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Important 
Note about 

the AAA

A corporation can make distributions greater than the amount on line 6 of the M-2, but 
those distributions could be taxable to the shareholders. Enter distributions on the 
DIST screen; this way, the amounts flow automatically to Schedules M-2 and K-1 but 
are limited based on the rules described previously. (For more information on the 
DIST screen, see “Entering Distributions” on page 31.)

Line 7 is limited to the lesser of the amount for line 7 or the positive amount from line 
6. If line 6 is negative, line 7 is then limited to the positive amount on line 1. If line 1 
and line 6 are both negative, line 7 is completely disallowed on the Schedule M-2. 
Distributions are entered on the DIST screen to be reported to the shareholders, 
regardless of the Schedule M-2 limitation.The AAA cannot be negative as a result of 
distributions, but it can be negative if it arises from losses.

Column B, Other Adjustments Account

Use column b, Other Adjustments Account, of screen M2 to enter any amounts you 
want printed in the corresponding column of the printed return. Officer life insurance 
and applicable tax-exempt income flows to Schedule M-2, column b (“Other adjust-
ments account”), line 5. All other amounts (such as expenses) must be entered manu-
ally on the M2 screen.

Column C, Undistributed Taxable Income Previously Taxed

The total of column c cannot be negative. This column is active in an 1120S only if the 
entity was ever a “C” corporation (thus having earnings and profit (E&P)) or if it was 
a pre-1983 S corporation. By design, Drake does not allow negative numbers in col-
umn c.

If a corporation becomes an S corporation and has net operating losses (NOLs), the 
NOL is not generated for the return because it cannot be carried to an 1120S (the IRS 
does not want the NOL to be used by the shareholders to offset income); it either runs 
out within the years allowable for the NOL by statute or is used if the S corporation 
terminates its “S” status within those years.

Rental Activities

Income and expenses for rental real estate properties appear on Form 8825, Rental 
Real Estate Income and Expenses of a Partnership or an S Corporation. To make 
entries in Drake, use the 8825 screen.
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If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use 
one screen per rental property. If a return has more than one 8825 screen, the program 
reports each property’s information on a separate column of the “Properties” section 
of Form 8825 (up to eight properties can be included on a form). Data from all 8825 
screens are transmitted to the IRS when the return is e-filed.

Line 14, Depreciation

If the program is calculating depreciation (entered on the 4562 screen) for the property 
listed on Form 8825, do not enter the depreciation on the 8825 screen. Depreciation 
should be entered only if it is figured outside of the Drake program, and then the net 
results should be entered on screen 8825. The amount entered on line 14 is added to 
the depreciation calculated from the 4562 screens.

Carrying 
Information 

to Form 8825

To indicate that the information should be carried to Form 8825, select 8825 from the 
For drop list on screen 4562 (Figure 15). If there are multiple 8825 screens, use the 
Multi-form code box. For information on using the Multi-form code box, see the 
Drake Software User’s Manual: Tax Year 2013.

Figure 15: In this example, the program will carry the 4562 information
to the second 8825 screen created.

Any depreciation information entered on the 4562 screen is carried to the correct 
Form 8825, based on the form and multi-form code selections at the top of the 4562 
detail screens.

NOTE Special steps are required if using the trial balance worksheet for multi-
ple rentals. See “Rental Expenses” on page 53.

NOTE Form 4562 is required for assets placed in service during the year.

IMPORTANT

When selecting a multi-form code, note that the code 
should refer to an 8825 screen—not the 8825 form. For 
example, data from the second 8825 screen will be gen-
erated on the first Form 8825. To associate an asset with 
that information, you would enter a 2 for the screen (not 

a 1 for the form) in the Multi-form code box. For more 
information on Form 8825, see “Viewing Rental Activity 
Information,” below.
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Line 15, Other Expenses (list)

Enter meals and entertainment (subject to 50% limit) in the appropriate field on line 
15 of the 8825 screen. To enter additional other expenses, begin typing into the Addi-
tional other expenses field to open a Detail (CTRL+W) Worksheet. Enter descriptions 
and amounts on this worksheet. 

A statement from each 8825 property is printed with the return and is submitted to the 
IRS when the return is transmitted.

Figure 16: Other expenses are listed on accompanying statement;
in this instance, “STM_8825_02”

Use the K1P screen to enter rental income the S corporation receives on a K-1. This 
amount is carried to Form 8825, lines 20a and 20b. No entry is required on the 8825 
screen.

Viewing Rental Activity Information

Rental activity data is viewed on the 8825 forms and accompanying statements.

• 8825 Forms — The two-page Form 8825 can contain information for up to 
eight rental activities. Each Form 8825 in View mode contains up to eight 
rental activities. If more are entered, a second Form 8825 is created.

Figure 17: Multiple 8825 pages are created if more than eight rental activities.
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The Form 8825 in View mode consists of one or more pages (depending on 
the number of rental activities) listing up to four rental activities per page. If 
more than four rental activities are entered, scroll down to the second page of 
the Form 8825 when viewing.

• 8825 Statements — Statements are titled STM_8825_XX, where XX equals 
the instance of the 8825 screen. (For example, the statements for the first and 
second 8825 screens would be labeled STM_8825_01 and STM_8825_02, 
respectively.) There are also 8825 attachments (8825_ATT) for other report-
ing information.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. The program car-
ries the required adjustments to the appropriate line of the return and to either Sched-
ule M-1 or Schedule M-3.

Manually reducing the expenses or deductions or increasing the income for these 
credits causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following cred-
its:

• Form 6478, Alcohol and Cellulosic Biofuel Fuels Credit

• Form 8864, Biodiesel and Renewable Diesel Fuels Credit

• Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction or expense for the credit amounts 
for the following credits:

• Form 5884, Work Opportunity Credit

• Form 6765, Credit for Increasing Research Activities

• Form 8820, Orphan Drug Credit

• Form 8845, Indian Employment Credit

• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

• Form 8881, Credit for Small Employer Pension Plan Startup Costs

• Form 8844, Empowerment Zone and Renewal Community Credit

• Form 8912, Credit to Holders of Tax Credit Bonds

• Form 8932, Credit for Employer Differential Wage Payments

• Form 8941, Credit for Small Employer Health Insurance Premiums

Elections
Access the ELEC 
screen from the 
Miscellaneous tab 
of the Data Entry 
Menu.

The ability to make certain tax elections is included in the business packages. Elec-
tions are selected from the Return Elections section of the ELEC screen (Figure 18 
on page 37).
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Figure 18: Return Elections portion of ELEC screen

Making an Election in Drake

To indicate that the S corporation is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry 
Menu).

2. Make a selection from the Election drop list. (See Figure 19.)

Figure 19: Election drop list

3. Complete all other fields as applicable. Press F1 in any field to learn if a field is 
required for your selection and the type of information that may be needed. For 
example, the help text for the Other date or year-ending field shows that the 
field is required only for election options 15, 27, 28, 29, and 31, and it explains 
what, specifically, should be entered for each of these elections.
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Figure 20: Help text for Other date or year-ending field on ELEC screen

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “STM ELXX,” where “XX” is the number of the 
election. For example, election 01 (General Election Statement) is generated as “State-
ment EL01.”

The election statement includes the election title, election wording, and any additional 
information required for the election, such a date or amount.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

Making Changes on the Fly

Use the PRNT screen to override program defaults.

Suppressing/Forcing Items

To suppress the printing or production, or force the printing or production of certain 
documents, go to the PRNT screen and select the desired options. Many “on-the-fly” 
changes override the options established in Setup.

1120S Items These items can be “forced” (forcing the program to generate the item) on a return:

• 1125E Officer Information

• Schedules L and M-1

• Form 4562 (Depreciation and Amortization)

NOTE
If the election option you selected is not listed in the help text for a field, 
then that field should be left blank. For example, if you chose election 
01 (General Election Statement), you would not need to enter any-
thing into the Date or year-ending field (help text in Figure 20).
38 Tax Year 2013



Drake Software User’s Manual Supplement: S Corp Making Changes on the Fly
• Next-year depreciation listing

• “Inactive return” printed on first page of the 1120S

• Preparer and officer signature on printed copy of return

The following 1120S items can be “suppressed” (kept from being generated) on a 
return:

• Schedule M-2

• WK_M2 (Retained Earnings Reconciliation Worksheet)

• Form and worksheet references

K-1 Items The following K-1 items can be “forced” (forcing the program to generate the item) 
on a return:

• Shareholder’s adjusted basis worksheet (WK_SBAS)

• K-1 codes (page 2 of the Schedule K-1)

The following K-1 items can be “suppressed” (kept from being generated) on a return:

• Related documents: Schedule K-1, K-1 cover letter, K1_ATT worksheet (for K-1 
statement overflow), and shareholder’s adjusted basis worksheet (WK_SBAS)

• Marking of “Amended K-1” box on printed Schedule K-1

• K1-DIST worksheet

Overriding Other Setup Options

Filing instructions and envelope coversheets can be either forced or suppressed from 
the PRNT screen to override the global setting in Setup > Options > Optional Docu-
ments tab.

The PRNT screen also includes options to disable autobalance (see “Autobalance” on 
page 28), calculate the Form 2220 penalty, and prepare an extension (Form 7004) 
based on the data entered on screen 1. (See “Filing an Extension” on page 15.)

Guide to Overrides and Adjustments

An Adjustment Worksheet and an Override Worksheet, available through the FAQs, 
allow preparers to see what data or calculations are being affected when an entry is 
made in an override or adjustment field. These worksheets can provide a better under-
standing of how overrides and adjustments work in the software.

To access the worksheets, click the Screen Help button at the top of the FAQ screen, 
then click the link for the desired worksheet and wait for the worksheet to be dis-

NOTE
Form and worksheet references are for the benefit of the preparer 
and client but are not required for the tax return. References appear 
on tax forms to clarify which worksheets (available in View mode) cor-
respond to which calculations, and which forms/screens certain 
amounts are carried from.
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played as a PDF file. An Internet connection and Adobe Reader are required in order 
to view the worksheets.

Much of the information contained in the worksheets is also available from the field-
level helps within the program. To access a field-level help, click inside a field and 
press F1, or right-click in a field and select Help > Help for this Field.

Electronic Filing

Steps for e-filing Form 1120S are the same as for e-filing Form 1040, with the excep-
tion of bankruptcy returns, which must be paper-filed.

Calendar year returns are due on March 17, 2014. Fiscal year returns are due on the 
15th day of the third month (two and a half months) after the S corporation’s year end. 
Returns can be e-filed after these dates; however, if an extension has not been filed, 
penalties and interest are applied.

Additional Return Types

Short-year returns, 52–53-week year returns, and inactive returns can all be e-filed 
using Drake. For information on how to indicate a short-year return in Drake, see 
“Short-Year Returns” on page 5. Information on e-filing 52–53-week returns and 
short-year returns is provided in the following sections.

Electing a 
52-53–Week 
Year (Initial 

Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the ELEC screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year begins and 
Fiscal year ends dates. Use MMDDYYYY format, as shown in the example in 
Figure 21 on page 41.

2. Mark the 52-53-week tax year box.

NOTES

An S corporation with $10 million or more in total assets that files 
250 or more returns a year is required to e-file its Form 1120S 
returns.

Every 1099, W-2, 940, and 941 form that is filed is counted as part 
of the 250-return threshold. For example, if a corporation filing an 
1120S return also files 150 W-2 forms, each W-2 would count as a 
separate return within the 250-return threshold.
40 Tax Year 2013



Drake Software User’s Manual Supplement: S Corp Electronic Filing
Figure 21: In this example, the fiscal year begins 09/29/2013 and ends 09/24/2014
(the Wednesday closest to the end of September), giving the entity a 53-week year for 2013.

3. Click the ELEC link to open the Election Options screen (Figure 22).

Figure 22: Elections for 52-53-week tax years

4. For line 1, select the month in which the 52-53–week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the 
Fiscal year ends field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

Inactive 
Returns

Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab.

2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, in the box above line 1c). Zeros are displayed 

NOTE
An entity that has filed returns in the past must complete only steps 1 
and 2 of this process. An entity that has never filed a return before must 
continue with steps 3 through 6.

NOTE
Once a 52-53–week year is selected, the entity must use that account-
ing period every year. To change accounting periods, the entity must 
submit to the IRS Form 3115, Application for Change in Accounting 
Method.
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where required by the IRS in order for amounts to be properly included in the e-file 
data.

For detailed instructions on e-filing returns in Drake, see Drake Software User’s Man-
ual: Tax Year 2013.

Common Error Codes

If one or more of the following IRS error reject codes is generated when e-filing an 
1120S return, the preparer must contact the IRS for further information.The IRS
e-Help Desk telephone number is (866) 255-0654.

• Reject Code R0000-900-01 — The return type indicated in the return header 
must match the return type established with the IRS for this EIN. If you get this 
reject code, you must contact the IRS to correct its database or paper-file this 
return.

• Reject Code R0000-90501 — Electronic Filing Identification Number (EFIN) in 
the return header must be listed in the e-file database and in “accepted status.” If 
you get this reject code, you must update your e-file application to include the 
1120S return type. This should be done at the IRS website. Review publication 
3112 for details.

• Reject Code F1120S-239-01 — Filer’s TIN and Name Control in the return 
header must match data in the e-file database unless Form 1120S, Item H (2), 
“Name Change” box is marked.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed and 
scanned into the computer (or “saved” as a PDF document), and attached to the return 
in order to be e-filed with the return.

You can attach PDF files to federal S corporation 1120S returns for e-filing. The PDF 
Attachments screen is accessible from the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF document to be attached

2. Informing the program that a PDF document will be sent with the return

3. Attaching the PDF document for e-filing

NOTE All EF messages must be cleared in order to e-file an inactive return.
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These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return.

2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Adding PDF 
Documents 

in Drake

To indicate in the software that a PDF document will be sent with the return:

1. Open the return in Drake. From the Data Entry Menu, click PDF Attachments 
(or type PDF in the selector field and press ENTER).(See Figure 23.)

 

Figure 23: Select PDF Attachments, or type PDF into the selector field and press ENTER

2. Fill out the columns on the PDF Attachments screen. See Table 3 for examples.

Table 3: PDF Attachment Window Columns

3. Exit the PDF Attachments window.

TIP It’s a good idea to use the DDM scanning feature for this step.

NOTE
Many types of documents (for instance, documents created in Microsoft 
Word) can be printed or “saved” as PDF documents if you have a PDF 
printer (such as Adobe Reader) installed.

Name of Column Description Examples

Reference Source Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 1120S

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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Because you’ve indicated that a PDF document is attached, the program generates an 
EF message page regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the toolbar, click View. If anything was entered in the PDF Attachments 
window (see “Adding PDF Documents in Drake,” previously), there will be two 
PDF–related items in the View/Print window:

• An EF Message (item #1 in Figure 24)

• An Attach PDF button on the toolbar (item #2 in Figure 24)

Figure 24: The Message file and the Attach PDF button

2. Click the Message file to view EF messages, including information on how to 
attach the required documents to the return.

3. Click the Attach PDF button. The EF PDF Attachments window displays the 
information entered on the PDF Attachments window in data entry (Figure 25). 
A red X means the document has not yet been attached; a green check mark indi-
cates an attached document.

Figure 25: The EF PDF Attachments window

4. Click the row of a document to attach.

5. Click Browse.

6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-
ble-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return, recalculate to clear the EF message. The return is now ready to be 
e-filed.
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Printing Generated Documents

In some instances, Drake generates a document that must be printed, signed, and 
scanned back into the computer to be attached to the return. For example, if Form 
2553, Election by a Small Business Corporation, is present in an S corporation return, 
message 1513 is generated when the return is calculated.

Figure 26: EF message page

As shown in Figure 26, the EF message states that attachments are required. You 
would then need to obtain or complete the statements, scan them into the computer, 
save them as PDF documents, and attach them to the return.

Importing Trial Balance Information

Drake’s trial balance import feature allows data to be imported into an 1120S return 
from a trial balance worksheet. The trial balance template and importing function has 
the following benefits:

• Eliminates the need to duplicate entries

• Reduces data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in 
Drake 2008 or later. If you haven’t already, create a client file in Drake or update an 

NOTE A flow chart of the trial balance importing process is available as an 
appendix at the end of this manual.
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existing client file from the prior year. Like several other functions of the tax software, 
this feature requires Microsoft Excel (version 2000 or later).

In addition, take these actions to ensure the trial balance import works properly:

• Activate Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro security is set to “medium.” To do so, go to Tools > Options in Excel and 
select the Security tab. Click Macro Security and select Medium, then click 
OK.

• Disable Autobalance — (optional) When autobalance is disabled, the program is 
prevented from automatically adjusting the year-end retained earnings or capital 
amounts, thus allowing you to see any discrepancies in the balance sheet. To dis-
able autobalance, go to the PRNT screen and select Turn off autobalance.

Figure 27: Disable autobalance in the
Calculations and Other Options section of PRNT screen

• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the entity does not meet the filing requirement. If this is 
the case, you must override the default setting in order to have the amounts shown 
on Schedule L. To force the Schedule L amounts to be printed, go to the PRNT 
screen and select the Force-print Schedules L and M-1 box.

Figure 28: Force Schedule L box for 1120S package

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail 
(CTRL+W) worksheets that are not required. For example, the IRS does not 
require a detail worksheet for the Gross receipts field on the INC screen; if a 
return has a detail worksheet for that field, the trial balance will not be imported 

NOTE

In Excel 2007 and 2010, click the Office button in the upper left and 
then click the Excel Options button at the bottom of the window. (In 
Excel 2013, click the File tab then select Options from the menu on the 
left.) Next, select Trust Center from the list at left, then click the Trust 
Center Settings button. Select Macro Settings from the list on the left, 
then choose Disable all macros with notification. Click OK and then 
OK.
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correctly into the return. Detail worksheets are indicated by red shading, as shown 
in Figure 29.

Figure 29: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” 
on page 49 for more information on using detail worksheets in the trial balance.

Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered 
into Drake’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.

2. Click Import > Trial Balance Import in the menu toolbar. The preliminary Trial 
Balance Import dialog box is opened.

3. Click Create New or Open Existing. If opening an existing file, click Open after 
selecting the correct file.

4. If a Security Warning box appears, click Enable Macros.

The trial balance template is displayed in Microsoft Excel.

Naming 
Convention

Whenever a new template is opened, the tax software assigns it a default file location 
and name. Trial balance templates are saved in the TB folder of your Drake13 soft-
ware. 

To change the name of a file in Excel, select File > Save As and assign the new name.

NOTE
In Excel 2007 and 2010 you may see a Security Warning message 
with an Options button. Click Options to open the Security Options 
dialog box, then select Enable this content. Click OK. (In Excel 2013, 
click Enable Content.)

NOTE
If saving a trial balance to a different location, make a note of where 
you’re storing it. The program automatically looks in the default direc-
tory.
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Template 
Structure

The trial balance template consists of three title rows and six columns. The Entity 
Name and Year End title rows can be edited; double-click a row to change the title. 
Columns are described in Table 4.

Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; a cell showing whether or not the bal-
ance sheet is out of balance and, if applicable, the out-of-balance amount (Figure 30; 
see also Figure 33 on page 50).

Figure 30: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0) and are not gray.

Table 4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake to which the debit or credit 
amount is imported

Form, Page, Sch, and/or line Location of the amount on the printed return

Other information Additional details for preparers; see “Details for Pre-
parers” on page 51.

NOTE
Some data cannot be imported with the trial balance and must be 
entered directly into the data entry fields within the program. For more 
on these categories of data, see “Special Conditions” on page 51.
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Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons. (If these cells do not work, you may need to enable them; see the 
Note in “Opening a Template” on page 47.)

Figure 31: Example of cells that require worksheets

Click a worksheet button to open a worksheet in a new tab. Figure 32 shows an exam-
ple of the “Other Income” worksheet.

Figure 32: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the SBS TB tab (labeled “1” in Figure 32), 
or click the Click to return to TB button above the worksheet tabs (labeled “2” in 
Figure 32). Note that a detail tab (the “Other Income” tab in the lower left of 
Figure 32) might include one or more detail worksheets (labeled “3” in Figure 32).

NOTE
Do not create detail worksheets in data entry if the trial balance work-
sheet does not provide an equivalent detail worksheet, or the trial bal-
ance will not be imported correctly.
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Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 33).

Figure 33: Out-of-balance amount is highlighted if columns are out of balance.

In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the software.

Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. (In Excel 
2007 and 2010, click the Office button in the upper-left corner and select Save. In 
Excel 2013, click the File tab then Save.) To re-name a file when saving, select File > 
Save As. For more information on file names in the trial balance program, see “Nam-
ing Convention” on page 47.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake, the trial balance 
information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.

2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 
Trial Balance Import dialog box is opened.

3. Click Next.

4. Enter or select the trial balance file to be imported. If necessary, click the button to 
the right of 1. Import File Name to browse to the proper folder. By default, each 
trial balance file is an Excel (.xls) file showing the client name and ending in 
“TB” for trial balance, as shown in the example in Figure 34 on page 51. (See 
“Naming Convention” on page 47.)

NOTE The data cannot be imported if the worksheet is out of balance.

NOTES

Not all trial balance data can be imported directly into a return. For 
information on program limitations, see “Special Conditions” on 
page 51.

If you are already in the Trial Balance Import tool for the selected 
return, go to the Trial Balance Import window in Drake and start at 
Step 3 of the following procedure.
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Figure 34: Selected file to import

5. Select the Trial Balance Additional Import Options. (See “Additional Import 
Options” following this procedure.)

6. Click Next and wait for the import to be completed.

7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

Additional 
Import 

Options

The program can import the following additional information when importing the trial 
balance data (select the items to import or click Select All):

Special Conditions

Some items cannot be entered into the trial balance worksheet and must be typed 
directly into data entry. Other items should be entered into the worksheet for balance 
purposes but are not imported to data entry; these must be entered separately and the 
calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most items go directly to the location indicated in the program and on the return. For 
example, the amounts shown in Figure 35 go to Schedule L, line 1, column d in the 
program and are shown on page 4, Schedule L, line 1, column d of the 1120S return.

Figure 35: Indication of where an amount will go in Drake and on the return

NOTE
If the program does not calculate the trial-balance information as 
expected, you can return to the trial balance worksheet, make adjust-
ments, and import the worksheet again.

Buildings & other depreciable assets Accumulated depreciation

Land Goodwill & other intangible assets

Accumulated amortization 8825/Rent information

Cost of goods sold depreciation
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Not all figures are imported directly, however, and some amounts are optional. Use the 
“Other Information” column to indicate special conditions and additional information 
regarding certain rows. Table 5 describes the most common notes in this column.

All “does not carry” notes are accompanied by further instructions in the column to 
the left of the “Reported on” column, as shown in Figure 36.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “does not carry” on the trial balance.

Figure 36: SCH2 screen required for “do not carry” items

To complete an SCH2 detail screen in data entry:

1. Open the SCH2 screen in the return.

2. Select the line number from the SCH2 drop list.

3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat 
steps 2 and 3. Data is saved automatically upon entry.

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is 
not included in the totals shown on the trial balance.

does not carry Information cannot be imported and must be entered on the 
appropriate screen in Drake. Screen is specified in 
“Reported on” column.

optional Amount is optional; not required for import, but could require 
direct entry in the software.

enter as negative number Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases”; when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Form 1125-A calculation.

[Form or Schedule] may be 
required

Non-financial information must be completed in Drake, in 
addition to the financial data entered in the worksheet.
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When the return is produced, the Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screen.

See “The SCH2 Screen” on page 27 for more details on using the SCH2 screen.

Depreciation S corporation returns can have up to four components of total depreciation:

• COGS 

• Real estate rental

• Rental other than real estate

• Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate 
fields on the trial balance worksheet. Note that, for 1120S trial balances, rental 
expense detail worksheets are required for 8825 and RENT depreciation.

When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Form 1125-A of the return, and the rental deprecia-
tion expense amounts flow directly to the appropriate lines of the 8825 and RENT 
screens, as applicable. Because the remaining depreciation can comprise any number 
of assets, the amount entered on the trial balance does not flow to the return. To ensure 
that each component of the total remaining depreciation is calculated into the return, 
each asset must be entered on the applicable depreciation screens in data entry 
(Figure 37).

Figure 37: Enter depreciable asset data on a 4562 detail screen, or enter the total depreciation 
on the override screens (screens 6, 7, 8, and 9). (Figure is from 1120S data entry menu.)

Rental 
Expenses

The following information applies only to S corporations with multiple rental proper-
ties.

NOTE
Enter 8825 and RENT depreciation amounts in the detail work-
sheets for importing purposes, but be aware that the 8825 and 
RENT screens in the program will have to be edited if 4562 detail 
screens (see Figure 37) are used.

NOTE

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a way 
to check that the amount on line 1 of Schedule M-1 is correct. Compare 
the calculated line 1 at the bottom of the trial balance to the equivalent 
line on Schedule M-1 of the calculated return. If the depreciation 
amounts match but the line 1 amounts differ, an M-1 adjustment could 
be required.
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The S corporation trial balances include lines for rental income and expenses. Both 
rental expense items require a trial balance detail worksheet.

Figure 38: Rental expense rows on an S corporation trial balance worksheet

When imported, the rental expense data entered on the trial balance worksheet appears 
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than 
real estate).

Because the trial balance worksheet has only one detail screen per rental type, the 
importing function does not accommodate entities with multiple rental properties or 
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.

2. Enter the income totals on the trial balance sheet and the expense totals on the 
applicable detail sheets (Figure 38).

3. Ensure that the balance sheet is in balance.

4. Import the trial balance worksheet into the return. The applicable screens in data 
entry now contain the figures entered on the trial balance worksheet.

5. Enter the amounts on additional screens that require details. (For more informa-
tion on data that cannot be imported, see “Special Conditions” on page 51.)

6. Compare the M-1, line 1 amount on the trial balance to the M-1, line 1 amount on 
the calculated return to ensure that they match.

7. Complete all 8825 or RENT screens in data entry, as applicable, for the individual 
rental properties or items.

NOTE
If the amounts do not match, review the imported amounts to ensure 
that all data was imported. If the data appears to have imported cor-
rectly, an M-1 adjustment could be necessary.
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8. Delete the 8825 and RENT screens that were imported from the trial balance (the 
screens reflecting the total rental expenses).

Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item. Drake customers can fill out Form 3115 and related schedules and 
attachments for corporation returns. This section provides instructions for completing 
this form and related schedules and attachments in Drake.

Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible 
from the Change in Accounting Method box, located under the Other Forms tab of 
the Data Entry Menu (Figure 39).

Figure 39: Screens for Form 3115, Application for Change in Accounting Method

The screens accessible from the Change in Accounting Method section include:

NOTE
To delete a screen in data entry, open the screen and press CTRL+D. If 
a multiple forms list appears, ensure that the screen to delete is 
selected, then click Delete.

NOTES

In some cases, Form 3115 must still be paper-filed. See “Parts I 
and III,” starting on page 56, for details.

Applicants filing Form 3115 must refer to the Internal Revenue Bul-
letins (available at www.irs.gov) to determine if the IRS has pub-
lished an accounting method revenue procedure, revenue ruling, 
notice, regulation, or other guidance relating to the specific method 
to be changed. See Pub. 538, Accounting Periods and Methods.
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• Screen 3115 (Change in Accounting Method) — Used to access fields for Form 
3115, including Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the software

• Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 40) 
that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake. The first should be 1, the second 2, and so on. When using 
other screens, such as the 311E or ATT screens, you can use those numbers to indicate 
which instance of Form 3115 the 311E or ATT screen should be associated with; see 
“Screen 311E Multi-form Codes” on page 62 for more information.

Form 3115 Screens

When you open the 3115 screen from the Data Entry Menu, the program displays the 
first of five 3115 screens. These five screens are:

• Parts I, III (Form 3115, Parts I and III)

• Parts II, IV (Form 3115, Parts II and IV)

• A, B, C (Form 3115, Schedules A, B, and C)

• D - I, II (Form 3115, Schedule D, Parts I and II)

• D - III (Form 3115, Schedule D, Part III)

As shown in Figure 40, you can access these 3115 screens by clicking the links at the 
top of any 3115 screen.

Figure 40: Tab links and Multi-form code field on 3115 screen

The next few sections of this document provide instructions for completing the vari-
ous screens for Form 3115 (including Schedules A through D).

Parts I and III Use the Parts I, III screen to complete the following sections of Form 3115:

• General Information

NOTE If only one Form 3115 is being submitted, you do not need to enter any-
thing in the Multi-form code box.
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• Part I, Information For Automatic Change Request

• Part III, Information For Advance Consent Request

General 
Information

Complete all applicable fields in the General Information section. Note that the 
fields for business activity and tax-year change are override fields (Figure 41). Com-
plete these fields only if you want to override the equivalent information entered on 
screen 1 or screen K.

Figure 41: Override fields in the General Information sections of the Parts I, III screen

Part I Not all applicants are eligible to use the automatic change request procedures. After 
answering 1a, 1b, and 2 in Part I - Information for Automatic Change Request, 
click the blue Parts II, IV tab at the top of the screen.

In the Part II – Information for All Requests section of screen Parts II, IV, answer 
question 3 (see Figure 42). If the answer is Yes, you are stating that:

• The entity would be required to take the entire amount of the section 481(a) 
adjustment into account in computing taxable income for the year of change.

• Section 4.02(5) of Rev. Proc. 2011-14 applies to the applicant’s accounting 
method change request, and the applicant is therefore not eligible for a change 
under automatic change request procedures. (See IRS Form 3115 instructions for 
details.)

Figure 42: Automatic Change Request information

Part III If the Part III section of the Parts I, III screen is filled out, Form 3115 cannot be 
e-filed with the return. It must instead be paper-filed before submitting the return. A 

NOTE Information should be entered in either the Part I section or the Part III 
section, but not both.
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user fee (a check or money order payable to the IRS) must be included with the paper-
filed form.

If the applicant qualifies for a reduced user fee, put a check mark in the box on line 
23b and go to screen ATT2 to complete the attachment information in the Part III, 
line 23b section (located in the bottom half of the screen). Include the necessary infor-
mation or certification required by Rev. Proc. 2012-1 (or its successor).

Specific statements must also be attached to the return if the applicant answers Yes for 
line 18 (“Is change request allowed under automatic change?”) of Part III, or No for 
line 22 (“All members of consolidated group use proposed method?”). Press F1 in a 
specific field for more information on attachment requirements. The method for 
attaching statements in Drake is covered in “Attachments,” starting on page 63.

Parts II and 
IV

In addition to the Multi-form code text box, the Parts II, IV screen consists of the 
Part II and Part IV sections, used to complete the following sections of Form 3115:

• Part II, Information For All Requests

• Part IV, Section 481(a) Adjustment

Applicants must complete both sections of this screen. For more on each line (includ-
ing instructions for required attachments), press F1 in a specific field.

Part II, Line 12 Note that there is no field on the Parts II, IV screen for Part II, line 12. Fields for line 
12, which should be completed if the applicant is changing only the accounting 
method for a particular item or items, are located in the top half of ATT2 screen. Use 
these fields to enter information on:

• The items being changed

• The applicant’s present and proposed methods for the items being changed

• The applicant’s present overall method of accounting (cash, accrual, or hybrid)

Note that the bottom half of the ATT2 screen is for completing Part III, line 23b. Only 
the top half (for Part II, line 12) needs to be completed for Part II, line 12.

Schedules A, 
B, and C

Click the A, B, C link from screen 3115 to complete the following sections of Form 
3115:

• Schedule A, Change in Overall Method of Accounting (screen covers Part 1, 
Change in Overall Method)

• Schedule B, Change to the Deferral Method for Advance Payments

NOTES
See Appendix A of Rev. Proc. 2012-1 (or its successor) for more 
information. For more on applicants who must apply for advance 
consent, see the IRS Form 3115 instructions.

Taxpayers filing under an automatic change request procedure do 
not pay a user fee.
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• Schedule C, Changes Within the LIFO Inventory Method (screen covers both Part 
I, General LIFO Information, and Part II, Change in Pooling Inventories)

Schedule A This section is required for all applicants filing to change their overall method of 
accounting. It requires the entry of amounts as they were at the close of the tax year 
preceding the year of the requested change.

The IRS requires a worksheet for lines 1a, 1c, 1d, 1e, and 1f of Schedule A. When you 
enter an amount on any of these lines in Drake, a CTRL+W worksheet is automatically 
opened, allowing you to enter the descriptions and amounts of multiple items for the 
worksheet. When you close a CTRL+W worksheet, the program returns to the original 
screen and displays the total in the field. The field is shaded (default is red) to indicate 
that a CTRL+W worksheet has been used. 

Schedule B This section has just two lines, both referring to the request for deferral for advance 
payments:

• Line 1 — Request change to the deferral method for advance payments (from sec-
tion 5.02 of Rev. Proc. 2004-34)

• Line 2 — Request change to the deferral method for advance payments (from sec-
tion 1.451-5(b)(1)(ii))

See IRS Form 3115 instructions for more information on making these requests.

Schedule C This section has two parts:

• Part I (General LIFO Information) — This section is made up of attachment links 
(see Figure 47 on page 63). If any of the conditions on lines 1–6 match the entity’s 
situation, click the corresponding attachment link to access the ATT screen, 
where you can complete the required statement. (Select the corresponding line 
code from the Schedule drop list on the ATT screen.)

• Part II (Change in Pooling Inventories) — Enter the descriptions of the contents 
and the base years of the present and proposed pools. If any of the conditions on 
lines 2–4 match the entity’s situation, click the corresponding attachment link to 
access the ATT screen, where you can complete the required statement.

NOTE
Schedule A, Part II (Change to the Cash Method for Advance Consent 
Request) requires attachments and is not addressed on the A, B, C 
screen.

NOTE
Leave blank any lines that aren’t required for the entity’s application. 
Exclude amounts not attributable to the change in method of account-
ing—for example, amounts that correct a math or posting error, or that 
correct errors in calculating tax liability.

NOTE If nothing is entered in a Schedule A field, the program automatically 
displays the word “NONE” in the field on the generated form.
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Schedule D, 
Parts I and II

Use the D - Parts I, II screen to complete the following parts of Form 3115, Schedule 
D, Change in the Treatment of Long-Term Contracts Under Section 460, Inventories, 
or Other Section 263A Assets:

• Part I, Change in Reporting Income From Long-Term Contracts

• Part II, Change in Valuing Inventories Including Cost Allocation Changes

Schedule D, 
Part I

A long-term contract refers to any contract for the manufacture, building, installation, 
or construction of property that is not completed in the tax year in which it is entered 
into. Answer the questions in Part I that apply to the entity’s situation.

Schedule D, 
Part II

This section concerns changes in the identification and valuation methods of invento-
ries. Note that some lines require attachments. To access the ATT screen and complete 
a required statement, click the desired attachment link.

The items on this part of the screen match the items on the actual Form 3115, Sched-
ule D. For information on completing individual lines, see the Form 3115 instructions.

Schedule D, 
Part III

Use the D - III screen to complete Part III (Method of Cost Allocation) of Form 3115, 
Schedule D. Part III is required for any entity submitting either Part I or Part II. Screen 
D - III consists of the following sections:

• Section A, Allocation and Capitalization Methods

• Section B, Direct and Indirect Costs Required to be Allocated

• Section C, Other Costs Not Required to be Allocated

Section A Click the D3-1 Attachment link (Figure 43) to attach a description of the present and 
proposed methods used to capitalize direct and indirect costs.

Figure 43: Link to ATT screen for attaching statements

NOTE
If an entity is currently using a LIFO inventory method or submethod 
and is changing to another LIFO inventory method or submethod, Part 
II of Schedule D is not applicable. Use Schedule C, Changes Within the 
LIFO Inventory Method, instead.

NOTE

If the entity is unable to furnish a copy of Form 970 (line 5a), the attach-
ment must include the following statement:

“I certify that to the best of my knowledge and belief (name of applicant) 
properly elected the LIFO inventory method by filing Form 970 with its 
return for the tax year(s) ended (insert dates) and otherwise complied 
with the provisions of section 472(d) and Regulations section 1.472-3.”
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Sections 
B and C

These sections consist of a series of drop lists under a Present column and a Proposed 
column. “Present” refers to the current accounting method, while “proposed” refers to 
the requested change in accounting methods. You should address only the items neces-
sary; do not make a selection for any item for which an answer is not required for the 
entity’s situation.

For each item in sections B and C, you can:

• Select X — If you select X, the corresponding box on Form 3115 will be marked 
with an X. (See Figure 44.)

• Select B — If you select B, the corresponding box on Form 3115 will be left blank 
and an attachment will be required explaining why the line was left blank. (EF 
messages will outline which statements are missing. (See Figure 44.)

• Select nothing — If you select neither of the above options, “N/A” will appear in 
the corresponding box on Form 3115. No attachment is necessary for a box 
marked “N/A.” (See Figure 44.)

Figure 44: X was selected for column 1, lines 1-3; B was selected for column 1, line 4;
nothing has yet been selected for any other line. (See also Figure 45.)

To attach a statement for section B or C, click the D3-2 Attachment link at the top of 
Section B. (See Figure 45.) A single statement may contain all necessary explanations 
for sections B and C.

Figure 45: If any box is marked “B,” click the D3-2 Attachment link to open
the ATT screen and complete the fields for an attached statement.
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Schedule E

Use screen 311E, accessible from the Other Forms tab, to complete Schedule E, 
Change in Depreciation or Amortization.

Screen 311E 
Multi-form 

Codes

Unlike the other 3115 screens, screen 311E contains two multi-form code text boxes:

• Multi-form code for 3115 — This box is applicable if the return contains more 
than one Form 3115. Enter the code for the instance of the 3115 screen with which 
this 311E screen should be associated.

• Multi-form code for Sch E — This box is applicable if the return contains more 
than one Schedule E. (A separate 311E screen should be used for each property.) 
Assign each property a separate code in its Multi-form code for Sch E. This code 
enables you to associate any attachments with the correct Schedule E property. 
(See “Attachments” on page 63.)

If the return contains more than one Form 3115 and multiple instances of Schedule E, 
both multi-code fields should contain numbers. Figure 46 shows that the third instance 
of a Schedule E is to be associated with the second Form 3115 in the return.

Figure 46: Example of third instance of a Schedule E to be associated
with the second instance of a Form 3115.

Completing 
Schedule E

The 311E screen consists of four sections:

• Schedule E - Line 4a — Enter information on the type of property, the year it was 
placed in service, and the property’s use.

• Schedule E - Change in Depreciation or Amortization — This section covers 
all Schedule E items other than lines 4a and 7. Note that lines 5 and 6 are links to 
required attachments.

• Schedule E - Line 7 - Present Method and Schedule E - Line 7 - Proposed 
Method — For the line 7 sections, enter information on the Present Method and 
Proposed Method in the supplied text boxes and choose the applicable conven-
tion from the Applicable Convention drop list. Options are as follows:

NOTE
If changing this method under the automatic change request proce-
dures, see the “List of Automatic Accounting Method Changes” in the 
IRS Form 3115 instructions.

• HY — Half-Year • MM — Mid-month

• MQ — Mid-quarter • S/L — Straight line
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Attachments

Attached statements are required for many Form 3115 items. Depending on the nature 
of the attachment, you will attach statements to the form in one of two primary ways:

• From data entry — The ATT screen is the most common screen for attaching 
statements to Form 3115. The ATT2 screen is used for Part II, line 12, and Part 
III, line 23b. (See the “Parts I and III” on page 56 and “Parts II and IV” on page 58 
sections for more information on completing the ATT2 screen for these items.)

• From View mode — Used for PDF attachments.

 ATT Screen 
Attachments

There are two ways to access the ATT screen in Drake:

• From the Data Entry Menu — In the Change in Accounting Method section of 
the Other Forms tab, click ATT. (See Figure 39 on page 55.)

• From the line that requires an attachment — As shown in Figure 47, some 
lines have attachment links. Click an attachment link to open the ATT screen.

Figure 47: Attachment links from Schedule C (screen A, B, C)

Complete the following ATT fields, as applicable, for all ATT screen attachments:

• Multi-form codes — Use these boxes to associate the attachment with an 
instance of Form 3115 (if the return contains more than one), a particular Sched-
ule E property (if the return contains more than one Schedule E), or both. (See 
“Multi-form Codes” on page 56 for more information on multi-form codes.)

• Schedule — Select the line of the form or schedule with which the attachment is 
to be associated. If an item begins with a number, it refers to the part of Form 3115 
(for example, 2-4e refers to Part II, line 4e). If it begins with a letter, it refers to a 
particular Form 3115 schedule (for example, C2-b refers to Schedule C, line 2b; 
C2-5 refers to Schedule C, Part 2, line 5).

• Explanation — Enter the statement explanation. If the explanation requires more 
than 900 characters, press PAGE DOWN for a second screen.

NOTE
Not all lines that require statements include a link to the ATT screen. 
Always check the field-level help (press F1 in a field) to determine if a 
statement is required. The program produces an EF message if any 
required statements are missing.

NOTE
If the explanation requires more than seven screens, only the first 6,500 
characters of the explanation are transmitted with an e-filed Form 3115. 
There is no character limit for paper-filed returns.
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Additional 
ATT Fields

The ATT screen has a separate section to be used only for Part II, line 10. The IRS 
requires that the attached statement, in addition to providing an explanation, include 
the taxpayer’s name and ID number. Enter the name and ID number, and indicate if 
the ID number is an EIN, in the applicable fields at the bottom of the ATT screen 
(Figure 48).

Figure 48: Special section for entering taxpayer name and ID number
for Part II, line 10; located at bottom of the ATT screen.

PDF 
Attachments

Some Form 3115 items require the attachment of documents that cannot be created in 
Drake Software; for example, line 4d of Part II requires written consent from a direc-
tor. You can, however, attach such a document to the form as a PDF.

See the PDF screen for directions on generating and attaching PDF documents. Click 
the Screen Help button for directions on converting other types of documents into 
PDF.

When the return is generated, an “EF Attachments” worksheet is produced. (See 
Figure 49.) This worksheet shows, in table format, the Reference (section of Form 
3115), the Description, and the IRS-required Filename of each required PDF docu-
ment. This worksheet is displayed as EF_PDF~ in View mode.

Figure 49: Example of an EF Attachments worksheet

Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF messages (as applicable) when the return is calculated. All forms, schedules, EF 
messages, and worksheets are accessible from View mode.

EF messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 

NOTES

Do not enter data on the PDF screen itself. If using the directions pro-
vided on that screen, skip Step 2 of the “Completing the PDF Screen” 
section, which instructs you to fill out the columns at the bottom of the 
PDF screen.

A PDF document may be attached using any filename. When you 
attach the document, the program automatically assigns it the filename 
required by the IRS.
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specifically, are missing. To best understand which attachments are still required, 
compare the ATT screen and the EF_PDF~ worksheet to the list on the EF message 
page.

NOTE
All EF messages must be eliminated before the return is eligible for 
e-file. EF messages for Form 3115 attachments are eliminated 
when all required statements have been attached to the return. 
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Drake Software User’s Manual
Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a corporation tax return from 
a trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the fol-
lowing benefits:

• Eliminates the need to duplicate entries

• Eliminates data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
Tax Year 2013 A-1



Trial Balance Import: General Process
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Index

Numerics
52-53-week year returns 40

A
accounting method

changing 55–65
entering 6

accumulated adjustments account (Schedule M-2) 31, 32
address

change of 6
e-mail 20
entering on Form 1120S 5
foreign 22
on K-1 letter heading 25
out-of-state 4

adjusted basis worksheet 26, 39
adjustment fields 39
adjustments

depreciation 30
section 481 8
to income and expenses 36

advertising expenses 11
amended

1120S returns 6, 17
K-1 letters 26

amortization 12, 27
analysis of accounts (Schedule M-2) 31–33
asterisks (on K-1 codes) 22
attachments

binary (PDF) 42–45
Form 8825 statements 36

auto-balance 28

B
bad debts 8, 10
basis 26–27

see also adjusted basis worksheet
binary (PDF) attachments 4
book-to-tax differences (Schedule M-1) 29
business activity codes 6

C
calendar-year returns 5
change of name or address 6
charitable contributions 21

Client Communications Editor (for letters) 25
codes

business activity 6
error/reject 42
K-1 21, 39
miscellaneous (screen 1) 4
multi-form 34, 56, 62, 63
state 18

compensation of officers 9
compensation of shareholders 8
contact information (for state returns) 20
cost of goods sold, see  Schedule A (Cost of Goods Sold)
cover letters (K-1) 25
coversheets 39
credits 36
Ctrl+W (detail) worksheets 6, 7, 46

D
data entry

for state information 18
importing trial balance into 45–55

dates
of incorporation 6
payment (changing) 15
tax year 5

decrease to basis 26
deductions 8–12
depletion 11
depreciation 7

and auto-balance errors 29
expense 11
for cost of goods sold (Schedule A) 7
of rentals 34
on short-year returns 5
printing Form 4562 38
trial balance (business returns only) 53

detail (Ctrl+W) worksheets 6, 7, 46
direct debit of balance due 14–15
direct deposit of refunds 14
distributions 31
domestic production activities deduction 24
due dates 15

E
e-filing

Form 1120S 40
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PDF attachments 42–45
statements 28

electronic
funds withdrawal 14–15
signatures (PIN) 16

employer identification number (EIN) 6
envelope coversheets 39
error codes 42
estimates

2008 tax 13
underpayment of 14

expenses 8–12
exporting K-1 data 23
extensions 15

F
filing instructions 39
final return 6
fiscal year returns 5
foreign

addresses for shareholders 22
transactions 14, 20

Form 1125E 38
Form 2553 (Election by a Small Business Corporation) 4, 6
Form 3115 (Application for Change in Accounting Meth-

od) 55–65
Form 4136 (Credit for Federal Tax Paid on Fuels) 13
Form 4562 (Depreciation and Amortization) 34, 38
Form 4797 (Sales of Business Property) 7
Form 5884 (Work Opportunity Credit) 36
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit)

8, 36
Form 6765 (Credit for Increasing Research Activities) 36
Form 7004 (Application for Automatic Extension of Time 

to File) 15
Form 8050 (Direct Deposit of Corporate Tax Refund) 14
Form 8820 (Orphan Drug Credit) 36
Form 8825 (Rental Real Estate Income and Expenses of a 

Partnership or an S Corporation) 33–36
Form 8844 (Empowerment Zone and Renewal Community 

Credit) 36
Form 8845 (Indian Employment Credit) 36
Form 8846 (Credit for Employer Social Security and Medi-

care Taxes Paid on Certain Employee Tips) 10, 36
Form 8864 (Biodiesel and Renewable Diesel Fuels Credit)

8, 36
Form 8873 (Extraterritorial Income Exclusion) 12
Form 8881 (Credit for Small Employer Pension Plan Start-

up Costs) 36
Form 8903 (Domestic Production Activities Deduction) 24
Form 8912 (Credit to Holders of Tax Bonds) 36
Form 8912 (Credit to Holders of Tax Credit Bonds) 36
Form 8916-A (Supplemental Attachment to Schedule M-3)

30
Form 8932 (Credit for Employer Differential Wage Pay-

ments) 36
Form 8941 (Credit for Small Employer Health Insurance 

Premiums) 36
Form 8941 (Credit for Small Employer Health-Insurance 

Premiums) 12
Form T (Forest Activities Schedules) 11

G
gains and losses 7
gross receipts 6

H
header information 5

I
import, trial balance 45–55
inactive returns 39, 41
income 6–8
increase to basis 26
instructions for filing 39
insurance proceeds, income from 8
interest

expense 11
income 8

inventory 7

K
K-1, Schedule for 1120S 21–27

L
labor 8
letters (K-1) 25

M
maintenance costs 9
Multi-State Apportionment 18

N
name change 6
net operating losses (NOL) 33
next-year depreciation listing 39
number of shareholders 6

O
officer compensation 9
ordinary gains and losses 7
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other
adjustments account 33
costs (Schedule A) 7
income (loss) 8

overrides 39
ownership

percentages 9

P
passive income 12
PDF (binary) attachments 4, 42–45
percentage, stock and ownership 9
PIN (electronic) signatures 16
printing

cover letter for K-1 25
K-1 items 22
line 22a worksheet 13
statements for Schedule L 27
suppressing/forcing documents 38

R
real estate 53
receipts 6
references to forms and worksheets 39
refunds

direct deposit of 14
state tax 8

reject codes 42
rent paid on business property 10
rental activities 33–36
repair costs 9
retained earnings reconciliation (worksheet) 39
returns

52-53-week year 40
amended 17
bankruptcy 40
extensions for 13, 15
fiscal and calendar year 5
inactive 41
short-year 5
signing 16
tax-exempt organizations (990) 42–45
updating prior-year 3

revocation of S election 6

S
S corporation

changing to 4
electing as 4
termination of 6

scanning (PDFs for e-filing) 42

SCH2 screen (for Schedule L) 27
Schedule B (Other Information) 17
Schedule D (Capital Gains and Losses and Built-In Gains)

Parts I, III, and III 13
Schedule K (Shareholders’ Pro Rata Share Items) 20–21
Schedule K-1 (Shareholder Information) 21–27
Schedule L 38
Schedule L (Balance Sheet per Books) 27–29
Schedule M-1 29, 38
Schedule M-2 31–33
Schedule M-3 30
schedules on Form 3115 58–62
section

179 income limitations 8
481 adjustments 8
481(a) adjustments 57, 58

Selector field 2
shareholders

adjusted basis worksheet 26–27
compensation of 8
foreign addresses for 22
multiple 22
number of 6
Schedule K-1 21
updating data annually 26

short-year returns 5
signatures, electronic 16
state

address 4
codes 18
-specific information 18
tax refunds 8, 14

T
tax

and payments 12–13
on fuels, credit for 8
returns, see returns
years (fiscal vs calendar) 5

taxes and licenses 10
termination of S election 6
trial balance import

and depreciation 7
and Schedule L 27, 28
instructions for using 45–55

U
underpayment of estimated tax 14
undistributed taxable income previously taxed 33
updating

an 1120S return 3
shareholder data annually 26
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V
vouchers 13

W
wages 8
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